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Chapter 1: Welcome to Novel Forge AI 

Your Creative Writing Companion 
Novel Forge AI is a writing suite for Windows that lets you plot, write and edit your next 
blockbuster novel or technical manual with panache, originality and complete privacy. Whether 
you are a first-time novelist or a seasoned hack churning out your 17th tawdry tale of 
star-crossed lovers, intergalactic intrigue and/or vampires, werewolves and/or zombies, Novel 
Forge has everything you need to turn that twinkle in your eye (nay, that burning desire deep, 
deep down) into a literary masterpiece (even if it is just another vampire novel). 

A Software Built for Writers (and by "writers", I mean me) 
And you don't have to take my word for it, mostly because nobody in their right mind listens to 
me anyway, especially when you can just read it for yourself: "Novel Forge is a one-time 
purchase software. No subscriptions. No internet connection required." And when you are not 
busily making more money by robbing the elderly, then this software is just what you need, 
especially if you want to write in a place where there is no internet, like on top of Mount Everest 
after some yaks have pushed you off the trail and now everything is covered in yak droppings. 
 
And NF does not use any of those proprietary file formats that lock you in, so that when (not if!) 
you abandon the program out of frustration and anger because things are not going well with 
this whole writing thing, you can still open your files with any text editor on any computer in the 
world! And backing up your work is as easy as copying a folder! Easy AND cheap! 

Built for Every Type of Writer Out There (And I'm Talking Every Freaking 
One) 
Pantsers? Check! Plotters? Check! Hybrid writers who sometimes just sit and stare into space, 
seemingly lost in thought but are actually wondering what in the hell they had for lunch that gave 
them gas? Double-check! Novel Forge AI has got you covered no matter how you write, or don't 
write, as the case may be. 
 
Here's a handy breakdown of who can benefit from using this fabulous software (and if you are 
NOT one of these people, then I am sorry to tell you that you will soon be on your own, because 
even after all these years in the business I still have no idea what kind of bizarre writing 
"method" could possibly work for you): 
 

-​ Pantsers  (aka Discovery Writers): These delightful folks just sit down and start making 
things up as they go along! Hahaha! As they say, "go with the flow"! And with Novel 
Forge's amazing array of tools at your fingertips, who knows what wonderful surprises 



await you as your story unfolds? Who cares about plot holes or gaping inconsistencies 
when you can have pure, unadulterated fun? 
 

-​ Plotters  (aka Outliners): If you are a plotter, then I know that you like things to be neat 
and orderly. You probably use index cards or some kind of software to keep track of 
everything in your story ("plot points," "sub-plots", "character arcs", blah, blah, blah). 
With Novel Forge's Plot Boards, Timelines and Character Cards, now you can have it all! 
Your outline is transformed into a stunning visual display that will impress the hell out of 
people (if impressing people is what you are after. If not, then screw 'em!). 
 

-​ Hybrid Writers Take a little of this and a little of that. Outline your major plot points, 
pants it through the rest of the novel. With Novel Forge AI, now you can! 

The Project-Based Approach 
At its core, Novel Forge is a project-based application. And when I say "project," what I am 
cleverly referring to, in this case, is that one folder (which you can also think of as the Place 
Where All The Crap Goes When You're Writing A Novel Because It Seems Important At 
The Time But After A While You Forget Why), it contains all the chapters, and notes, 
character sketches, descriptions of places and things, timelines, graphics files, transcripts of 
sessions with the AI that is so integral to the whole process... 
 
But this is not just an ordinary collection of files in a folder! Oh, nooooOOOooooo! This is so 
much more than THAT! It’s the fabulous project-based approach at work, which I will now 
explain with my usual unhelpful arrogance and completely tangential allusions to things that 
happened long ago. 
 

-​ All in One Convenient Location: Instead of having character notes scattered randomly 
like the contents of my medicine cabinet after an earthquake, everything is now neatly 
contained within the project folder! Hahaha! A novel-writing Swiss Army knife, in 
software form! 
 

-​ Stay Portable: With effortless grace, you can move entire folders of your project around, 
copy it with lightning reflexes, or even archive the whole thing into the dark, dank depths 
of some forgotten hard drive... 

 
-ALL of this  (yes, I am dramatically sweeping my arm across my chest like a grand maestro 
conducting an orchestra) is on YOUR computer! And not, as seems to be the trend these 
days, everything being "on the cloud" which sounds vaguely ominous. Maybe it's just another 
example of my bizarre paranoia about unseen enemies stealing my data with mind-control rays 
and/or genetically engineered zombie viruses that I read about in a science fiction novel 
sometime around 1960. 



What You Get With Novel Forge 
Taking a quick look from above, like when you fly over the Grand Canyon in an airplane and 
they tilt the wings so that everybody can get a good view of the Colorado River snaking its way 
along at the bottom of this huge freaking canyon that is slowly being eroded by the river, you will 
notice that Novel Forge contains: 
 
Nine handy dandy document windows; manuscript, character cards, setting cards, plot board, 
timeline, image wall, wordsheet, AI Chat, redline. 
 
Plus, there is a Style Assistant to teach you the vocabulary and sentence structure of your 
favorite authors so that you can steal their style (which is not as easy as it sounds). There are 
also 14+ Thematic Dictionaries covering genres, eras, and specific authors ("What would Jane 
Austen write if she were alive today?"). 
 
Plus a 140,000-word offline thesaurus at your fingertips! No internet connection required to 
instantly find that perfect word! 
 
There are 50+ AI Assistants ready to help with everything from grammar and spelling to 
suggesting better ways of phrasing something (paraphrasing), eliminating passive voice 
constructions, cutting down on those pesky adverbs ("He said sadly...") and even a 
Bestseller-O-Meter (which is not as accurate as it is amusing). 
 
Of course you can also just free-form chat with the AI about your story, or have it roleplay one of 
the characters so that you could interview them for background information. Or ask them what 
they think of my writing style and if there is anything I should be doing better to make this a 
more compelling read ("Get rid of all these parentheses!"). 
 
Did I mention the built-in Voice Reader? It has eight different voices, any of which can read your 
manuscript aloud to you so that you can catch those awkward phrases and typos that are 
glaringly obvious when you hear them. 
 
And with Redline Editing, you can mark up a copy of your manuscript (with comments like 
"Needs work!") without actually changing the original file. It's like having superpowers! 
 
Writing Aids such as spell checker, passive voice detection, adverb detector, Flesch-Kincaid 
readability metrics and more are all included to help hone your writing skills to razor sharpness. 
 
There is also a full-screen Distraction-Free Mode so that you can write without being distracted 
by shiny objects or curious onlookers ("What are you working on?"). 
 



And exporting options galore, so that you can export your finished manuscript in exactly the 
format you want (TXT, PDF, DOC, EPUB etc.). 
 
And, if for some reason all of that is NOT enough to make a serious novelist swoon with delight 
and faint dead away at the sheer brilliance of it all, then prepare yourself for (wait for it... wait for 
it...) a Monkey Novelist! Hahaha! A monkey! Writing novels! I know what you are thinking. You 
are saying "This random juxtaposition of disjointed sentence fragments does NOT seem original 
in the least, especially since the technology to produce such gibberish is now ubiquitous (Yes, 
I'm talking about AI)!" and you would be right, except that I am not stealing this idea from 
anybody, because I already used it earlier in THIS VERY PARAGRAPH! (Wait! What?) 
 

 

 



Chapter 2: Let's Do This! 

Installation & Initial Startup - The Fun Begins! 
1.​ Go to the official Novel Forge website at www.mediachance.com/Novel Forge and click 

on the "Download" button, which is cleverly disguised as a picture of a really cute puppy 
dog with big, soulful eyes, wearing a little bonnet, and it's sticking its tongue out in that 
adorable way that makes you want to say "Awwww!" (None of that is true, sadly, it's just 
a stupid Download button.) 

2.​ Install the program by double-clicking on the downloaded file This is where the fun really 
starts! 

3.​ Start the program 

Creating Your First Project 
The first time you launch Novel Forge, it will ask you to create a new project or load some 
Introduction project: 
 

1.​ Click on New (Hahaha! "New", which is code for "Screw everyone and everything in my 
life; from now on I am dedicating myself completely to drooling all over this ridiculously 
oversized monitor while feverishly typing gibberish into the screen, as befitting a raving 
lunatic!") 

2.​ A window pops up asking you where all your projects are located. By Default it will be 
\Documents\Novel Forge\Projects\ which is a great place to be. 

3.​ In the next field down (Project Name), enter the name of your project, which will usually 
be just the title of your novel or working title ("Untitled Project 128"). This is a name of a 
folder that will be created in the Projects location you specified above! How cool is that? 

4.​ Click on Create. Voilà! Novel Forge creates a new project folder, and populates it with 
default sub-folders for Manuscript, Characters, Settings, etc. There will be a .cquill file 
which is what binds all this together into a cohesive whole. 

 

http://www.mediachance.com/novelforge


The Interface: A Quick Guided Tour 
Now let me introduce you to the interface of Novel Forge! Look around! Get comfortable! Make 
yourself at home! I'll be your guide through this strange and wondrous land, a magical place 
where (it is said) even YOU can write a great novel with ease! Hahaha! With an arrogant laugh 
of contempt in my voice, because it is obvious from the preponderance of historical examples 
(100% certainty!) that only GENIUSES like you and me can truly create great literature. 
 
But this is not about how we both are surrounded by morons on this stupid planet full of idiots. 
This is about the interface! It has four main parts: 

The Project Tree (on the left) 
This is where your virtual filing cabinet is located, so that all the documents in your project are 
neatly stored away in their respective folders and subfolders. There will be a Manuscript folder 
by default, as well as Characters, Settings, Plots... and other useful things. Clicking on any of 
them opens it up for viewing (and editing!). 

The Editor (Center) 
This is your main workspace, and when you click on something in the Project Tree to open it, 
that's where it will appear! Isn't that handy? You can have multiple documents open at once, and 
they conveniently appear as tabs across the top of the screen, like a rollicking good time at a 
barn dance with all your friends. The tabbed interface also lets you easily arrange them 
side-by-side or stacked on top of each other (see Multi-Document Viewing below), so that you 
can quickly switch between comparing two documents open at once! It's like having X-ray 
vision, only cheaper! 

The Style Assistant and Thesaurus (Bottom and Right Panel) 
These panels show vocabulary suggestions as you type. The Style Assistant displays 
sentences from famous authors, while the Thesaurus provides synonyms. 
 
"Don't get distracted by shiny objects!" I keep telling myself. And then I remember that Chapter 
5 is devoted entirely to explaining them, so you can relax and take a break from reading this 
stupid manual, because nothing will ever be as good as 1990s. 

The AI Assistant (Bottom Panel) 
Here's where you will find over fifty handy AI writing assistants at the bottom of the screen! Fifty! 
I can hardly wait to use them all, and neither should you! Select some text in your document that 
you want to rewrite, click on an assistant, and— voila! —instantaneously get a bunch of 
suggestions! 
 



Actually no, you get an error, because you didn't set it up yet. The AI Assistant is one of those 
things that either need an internet (Booo!) or you can set it up entirely on your computer using 
tools like Ollama, LM Studio and other things that are free. 
 
In case you are as curious as most Earthling carbon-units (and if you aren't, then shame on 
you), we will be dedicating the entire Chapter 10 to this marvelous AI Assistants feature. So 
stop clicking on it. 

Opening and Closing Panels 
To display or hide any of the panels: 
 

1.​ Click on the View menu 
2.​ Select the panel you wish to show/hide by checking or unchecking it 

 
This is where the fun begins, as this allows you to customize your environment to suit your 
fancy! 
 
Pro Tip (Performance): And if you are writing something really long, like, I dunno, maybe a 
couplet or two about how the heroic Cranky Man stood up to and bravely said "No more!" then 
collapsing in a heap on the floor under the weight of crushing ennui because nobody cares what 
the stupid Cranky Man says anymore, you will find that your computer runs faster if you hide the 
Style Assistant panel and the Thesaurus panel. The reason is that Novel Forge isn't wasting 
time updating these panels in the background if you don;t care about them. 

 



Multi-Document Viewing 
This is particularly handy when you are writing a love scene and want to keep glancing at your 
notes on the hero's muscular build ("broad shouldered, rippling pecs, tight buns of steel") while 
simultaneously comparing it to the heroine's "scrawny little twit" physique as described in her file 
("stringy hair, bony elbows, flatulent"). 

Pinning Documents 
But sometimes you have a document open that you really, really want to keep open all the time 
(like your Outline or a particularly juicy Character Profile). With Novel Forge, you can find and 
select Pin on the left side, near the top. The tab will now remain open no matter what you do! 
Try it! Go ahead! Open one chapter, pin it, open another! Now you have two tabs! Isn't that 
neat? You have successfully created a quick window into your soul... or at least, pinned an 
important document in Novel Forge. 

Auto-Resume 
And if you are like me and spend a considerable amount of time away from the computer yelling 
at family members, then I have some good news for you: When you re-open Novel Forge, it will 
automatically return you to the last document that was open. It's like it remembers exactly where 
you were and what you were thinking... which is kind of creepy if you stop and think about it. 

 



Distraction-Free Mode (Zen mode) 
Activate Distraction-Free mode on your Manuscript (from the menu or pressing F11) when you 
want an environment devoid of distractions and filled with nothing but sublime, shimmering 
silence. The screen is completely taken over by your manuscript in stark black text on a light 
background (or the other way around), the very essence of "clean Zen interface." It's almost 
hypnotic...It's like being in a sensory deprivation tank, but with more text and less tank. 
 
To exit: Press ESC. 
 
While in Distraction-Free Mode, you have a bottom toolbar with four buttons: 
 

Button What It Does 

Exit Return to the normal editor or ESC 

Theme Switch between light and dark backgrounds 

Font Toggle between a proportional font and a 
monospace font 

Whitespace Show or hide paragraph marks and spaces 

 
A running word count is displayed at the bottom of the screen so that you can track your 
progress.  So, as long as you ain't asleep in front of the keyboard (which I can tell just by looking 
at your droopy eyelids and how your head keeps comically boinking against the desk), you can 
see exactly how many words you have written so far. 
 
And, for those of us who like to take our writing seriously all the way down to the minutiae of 
obsessive self-indulgence wrapped in narcissistic conceit and totally devoid of any real talent or 
discernible skill: 
 
*You can customize your writing environment in the menu Distraction Free - Setup (*aka "the 
cocoon where the Ugly Cranky Man Butterfly (UCMB) will emerge into a beautiful winged 
creature that soars on silver wings under a radiant sunbeam, dappling through the leaves of 
Elysian trees in some distant paradise") 
 
Here you can adjust the margin width to widen or narrow your text column, letting you control 
how wide open your mind is to new ideas (a wide-open mind being metaphorically represented 
by a wider left and right margin). You can also change the font size so that it is easier for you to 
read when using either the Light Theme or Dark Theme. And, of course, select a different font 
altogether! 



 
Your Distraction-Free settings (theme, font, margins) are stored globally, like some kind of 
"memory crystal" betweem sessions... 
 
Zen mode ends here. 

 



Saving Your Work 
Novel Forge uses a clever ploy known as "Auto-Saving", which saves your document every time 
you click another window. Therefore, clicking the big, ugly "Save" button (which I will now refer 
to as the Big Button Of Shame (BBOS)) is mostly redundant. If a piece of software is so lame 
that it makes me, the long-suffering Cranky Man in this age of AI, go through the ridiculous 
charade of pressing a Save button just to keep from losing my work every time I get distracted 
by some shiny object or loud noise, then there is something very, very wrong with both the 
software AND my parents for not raising me better than that). 
 
But for those times when we are not thinking clearly and our brain seems to have taken a long, 
leisurely stroll off into the sunset ("zzzzzz") we provide: 
 

-​ Save: Ctrl+S or menu Document - Save (to save this document) 
 

-​ Save Project: Ctrl+Shift+S or Menu Project - Save (to save all open documents in the 
project) 

 
Again, they are more or less Save NOW as in opposite to Save when the software feels like to 
save. 

What's Next? 
Now that you are all fired up and ready to write, here is how I suggest you proceed down the 
treacherous path of creating a novel with Novel Forge: 
 

-​ Want to know how to use Novel Forge to organize your novel? → Chapter 3 
(Projects and Organization) 

-​ Want to skip all that theory crap and just start writing something, anything, right 
now? → Just click on in the Manuscript folder in the left-hand navigation pane, which will 
open a new text document for you. It's easy! Do it today! 

-​ Want to get into that AI stuff? → Chapter 8 (Setting Up AI) 
-​ Are you completely new to this kind of writing software thing and have no idea what 

in the hell you are doing, but with a vague glimmer of hope that maybe, just maybe, this 
time things will be different because you finally got some smarts about how to approach 
it? Then keep reading, one chapter at a time. Take your time. 

 
 



Chapter 3: Projects and Organization 

What is a Project? 
Here in the magical land of Novel Forge, all your novels, scenes, outlines, character sketches, 
shopping lists (for snacks!), hate mail from family members who think you don't call them 
enough, everything...is contained within a Project.  It's like an organized drawer in a filing 
cabinet. Unlike my car, where everything is just randomly thrown into the trunk and now there 
seems to be some kind of weird smell. 
 
"So," you are wearily asking, your voice raspy and hoarse from overuse, "Why have Projects at 
all?" 
 
Well, for one thing, it keeps you from having random files strewn willy-nilly across your hard 
drive with cryptic names like "That Weird Smell In My Car.txt", which doesn't help when you are 
trying to remember what in the hell this file even IS about! 
 
And with a Project: 
 

-​ It's all neatly contained in one place. 
-​ You can easily back it up by simply copying the folder somewhere. Or sharing it with 

your loved ones so that they can learn a valuable lesson about responsibility keeping 
your files safe. 

-​ The important files are plain text, so you could theoretically open them and read them 
even after the Zombie AI apocalipse has turned everyone into ravenous robots except 
you, hiding in the closet under the stairs with your trusty AK-47 and a couple of hand 
grenades. Pew pew! Take that, AI bastards! 

-​ And it automatically sets up a whole directory structure for you, complete with subfolders 
and essential utilities all pre-configured and ready to go! How handy is THAT? 

Default Folders 
Every new project comes with these folders: 
 

-​ Manuscript Your main chapters and scenes. This is where the magic happens! 
-​ Notes For your research, random musings, brilliant (or not-so-brilliant) ideas that come 

to you while researching, like how the hero's journey could be a simple shopping trip 
gone horribly wrong ("Get milk. Get bread. Get revenge on family members who hate 
us.") or wondering if vampires sparkle in sunlight because they have sensitive skin and 
are wearing sunscreen (SPF 50+, broad spectrum). 



-​ Characters Character Cards for all your players, both the handsome heroes and the 
tragically flawed villains, depending on how the light hits them at just the right angle. You 
can even include their vital statistics! Height, weight, shoe size, favorite color, 
astrological sign, weird fetishes... you name it! 

-​ Settings Settings Cards to help you keep track of your locations and build a whole world 
from scratch with ease! 

-​ Plots Plot Boards for visually outlining your story using index cards that you can easily 
move around until you get the perfect plot. (P.S. This is also great for creating alternate 
storylines and branching narratives! Just create a new Plot file.) 

-​ Timelines Timeline documents to help manage multiple storylines and keep track of 
events in chronological order, ensuring that your story flows smoothly from beginning to 
end... or end to beginning, if you're feeling particularly avant-garde! 

-​ Images Image Walls where you can put up pictures of things that inspire you (or scare 
the living hell out of you), which is just as useful. 

-​ Wordsheets Grid documents that are perfect for making lists, tables of data, or anything 
else where an organized presentation is important. 

-​ Chat Logs of your conversations with the AI chatbots, and your flirtatious banter with 
them. 

-​ Snapshot Archive A magical place where previous drafts of your work can be stored, 
so that if you ever want to go back in time to relive an embarrassing moment when you 
were younger and thought you were such hot stuff, then you can. 

-​ Bin The Recycle Bin for things you accidentally throw away, only to discover that you 
need it back. Again. Well, it's still in the bin untill it's shreded. 

Creating New Documents 
To add a new document of a type to any folder: 
 

-​ Right-click the folder in the Project Tree (for example Manuscript) 
-​ Select **Add new item ** 
-​ The new document opens automatically for editing 

 
or 
 

-​ Double-click on in each folder 
 
or 
 

-​ Use menu: Document - Add New 

Creating User Folders 
You can also create your own personalized folders, allowing you to structure your project exactly 
as you wish: 



 
1.​ Right-click on any existing folder in the Project Tree view. A menu pops up. 
2.​ Select "Add New Folder After..." from the menu. A dialog box appears. 
3.​ Type in the name of the new folder, and click "OK". The folder is created! 

 
Now you can drag-and-drop any items into your snazzy new custom folders, regardless of what 
they are. Create a folder called, for instance, "Act 1", and stuff it with chapters, scenes, 
character sketches, plot outlines, research notes, hate mail from the kids asking for money, all in 
one convenient place! 
 
Pro Tip: As an alternative to stuffing everything into one big stinking folder labeled 
"Miscellaneous Crap", try to maintain at least some vestige of order by grouping character stuff 
together, keeping drafts separate from research notes and vice-versa, outlining story arcs with 
dedicated folders for each. 

 



Moving and Managing Documents 

Moving Documents 
This is where you drag and drop documents from one folder to another in the Project Tree. Go 
ahead! Drag them all around! They will not get tired, or complain about being dragged around 
as if they had "places to be". 
 
Smart Tags and Moving Documents: The Smart Tags on a document will not be affected by 
moving it around in the Project Tree! Novel Forge keeps track of where everything went, so your 
hyperlinks between documents still work even after you have completely rearranged the 
contents of your project from one end of the spectrum to the other. Like when you finally throw 
out that last, lingering shred of hope that your writing career will ever amount to anything and 
you decide to give the glories of gluttony another try. We allhave been there! 

Renaming Documents 
This may be hard to follow along with because it will soon degenerate into senseless babble, 
replete with pointless alliteration and ill-conceived rhyming that doesn't even make sense, but if 
you right click on a document in the Project Tree, and then select "Rename", you can type in a 
new name for that document and it can be anything you want. The title of the document is NOT 
the same as the filename (that's an internal matter). So you can have two documents with the 
exact same name in the same folder, which is probably very confusing if you ever try to find 
something. But hey! Do whatever makes YOU happy! 
 
Or, even more easily (and this is probably the part where it starts to become clear why I am 
such a raving idiot about alliteration and rhyme), simply click on the title bar of any open 
document, at the top of the screen, and you can change the name that way!  It's so easy that I 
am giggly with glee about it, which suits me fine. 
 
So: 
 

1.​ Right-click the document in the Project Tree 
2.​ Select Rename 
3.​ Type the new name, whatever you want it to be 

 
Or simply click the title bar at the top of an open document and edit it directly. 

Snap Shotting Documents 
So you want to take a "snapshot" of how things are with some document right now? Easy! Just: 
 

1.​ Right-click the document in the Project Tree 



2.​ Select Create Snapshot 
 
This nifty function creates a new, versioned copy of the document and stores it in the Snapshot 
Archive for you, which is basically a simple version control system, except without all those 
fancy doodads of GIT. It's particularly handy when dealing with wholesale changes, like 
replacing entire paragraphs with someone else's work, and then taking credit for it as if you had 
come up with it yourself. Plagiarism at its finest! And so easy, too! 
 
Snapshot a document and experiment boldly. You have a safety net. 

Deleting Documents 
You don't actually delete a document, per se; rather, you merely move it into the Bin, which is 
sort of like putting the offending item out with the trash for future collection day. You can still 
retrieve it by dragging it from the Bin back to any other folder. 
 
To send a document to the Bin, right-click on the document and select "Move to Bin", or simply 
drag the document into the Bin folder. 
 
As a Cranky bonus, you will find (to your delight, I am sure) that you can still open files in the bin 
as if they were normal documents. Can you imagine saving all your mail in the trash bin so that 
you could open it up, read it ("Dear Dad; Here is the $20 I owed you."), make a few marginal 
notes on the envelope ("That's only ten bucks! The little bastard cheated me out of another 
tenner!") and then toss it back into the stinking, rotting pile of festering refuse? Eewww! But hey! 
That's just me being picky again, isn't it? Just because you CAN do something doesn't mean 
you should. 
 
And when you are absolutely, positively sure that there isn't anything in the Bin that you might 
want to keep, then: 
 

1.​ Right-click the Bin folder 
2.​ Select Shred items in the Bin 

 
Warning: It pertains to permanently deleting the items in the Bin so that nobody can ever, ever, 
EVER get it back. Poof. 
 

 

 



The title bar of the document 
I already told you that you can change the name of the document in the title bar, and every 
document in Novel Forge has one of these title bars. But there are other things in it that may be 
confusing at first glance. Let's take a look! 

Color Tags 
With Color Tags in the document title bar, you can colorfully code your documents so that they 
are easily distinguished at a glance! Choose from our wide range of four terrific colors: pale 
Red, Blue, Yellow and Green! It's almost as good as having X-ray vision, but without the hassle 
of constantly getting government agents busting down my door and shouting about how it is 
dangerous to me and everyone around me. 

How To Use Color Tags: 
1.​ Right-click on a document in the Project Tree 
2.​ Select Color Tag → and then select a color. 

 
Now (cue the trumpets going taa-daaaaaaa!) Like magic, a little colored square appears next to 
the name of that file in the Project Tree! Ooh! Pretty! Now you can really start playing with your 
food... er, I mean, your story structure! For example: 
 

-​ POV: Red for Character A's point-of-view chapters and Blue for Character B 
-​ Revision Status: Green = Done. Yellow = In progress (and needs lots more work). Red 

= First draft, which means it is still so bad that even the people who love you can't bear 
to read it. Yet! 

-​ Scene Types: Use blue for action scenes, yellow for dialogue-heavy scenes and red for 
romance/intimacy/spicy scenes. 

-​ Priority: Red = Revise this now! It's important! 

Revision Markers 
Keep track of how many times you have rewritten a chapter: It's next to the Color Tag in the 
document title bar. Select "1" if this is your first draft (and probably last) of the chapter. If not, just 
keep incrementing from there. 
 
This way, at a glance you can instantly see which chapters are getting the most revisions! Or as 
Frank Sinatra would put it, perhaps more accurately described as (and I'm making this up), 
"'Which ones ain't so hot, and that's why they need more work!" 



Smart Tags 
Smart Tags turn your lonely, forlorn documents into a vibrant, bustling community of inter-related 
files! They are keywords with superpowers that you assign to a document (the operative word 
being "assign," as in "I hereby officially give this document a tag linking it to another document!") 

Smart Tag Powers Demystified 
1.​ The Linking Power - Click on an existing Smart Tag and, magically, the linked 

document appears! Like teleportation, but without the disconcerting crackle of 
dematerialization/rematerialization sound effects ("zzzt!" "Whoosh!"). 

2.​ The Auto-Update Power - Rename a linked document, and its corresponding Smart 
Tag is automatically updated to reflect the new name (or vice versa)! 3. The Color 
Inheritance Power - A Smart Tag assumes the color tag of the document it links to. 
Thus, if you have a "Yellow" Color tag on the original document, the tag pointing to this 
document will be also yellow. 

3.​ The Insert Text Power - With this awesome power, you can define a tag to insert 
boilerplate text into whatever document you are working on. For example, I have defined 
the tag "Disclaimer" to insert the following text when I click on it: "Please remember that I 
am an idiot and know nothing about anything, so don't take my word for it or rely upon 
me in any way, shape or form." 

4.​ The Web Search Power - This handy power lets you create a tag which, when clicked, 
will search the web (using your default browser) for whatever words are currently 
selected in your document! 

5.​ The Simple Keyword Power - The most basic of all powers, this is where you merely 
use Smart Tags as simple keywords without any action to help organize your files into 
categories. Well, you can still use it as search option. 

Creating Smart Tags 
1.​ Click the "+" button in the Smart Tags area (the title bar on top of your document) 
2.​ Choose a tag from the top list: 

-​ Link to an existing document in your project 
-​ Create a User Defined Tag that can do some action - simply type some name in 

the text bar in the middle and choose a color 

Finding Documents by Tags 
Use Document → Search for Tags to find all documents with a specific tag. This is perfect for: 
 

-​ Find every scene that features a specific character (by their identifying tag) 
-​ Filter the scenes into neat little piles, such as "action," "dialogue," or "flashback" 



-​ Quickly identify and track all the chapters/scenes that have some other distinguishing 
feature that you can exploit with tags 

 
Okay, I admit it; to fully appreciate the power of smart tags in your document, you will need to 
spend a little time playing around with them. It's up to you! 

User Defined Tags 
For tags you use frequently, add them to User Defined Tags. These appear in User Defined 
Tags binder for quick reuse across all your documents. 
 

 

 



Chapter 4: Document Types 
Novel Forge has many different kinds of documents, each with a unique purpose related to 
writing. This chapter will tell you what they are and how to use them. 

Manuscript (Text documents) 
Text documents are where the magic happens; this is where you write your chapters, scenes, 
notes, or anything else that needs to be written in prose. 
 
Texts in manuscript can be exported to different documents such as DOC or PDF. 

How to Create a Text Document 
1.​ Right-click the Manuscript folder in the Project Tree 
2.​ Select Add new item 
3.​ Start typing in the editor 

Key Features 
-​ Full-featured editor with spell checking 
-​ Integration with the Style Assistant, Thesaurus and AI Assistant 
-​ Word count and statistics in the status bar 
-​ Revision tracking 
-​ Auto-save 
-​ Send to Redline for editorial markup (see Chapter 11) 

Tips for Writers 
One chapter per document is a brilliant idea. Stick to it. The Manuscript folder is your main draft 
that you polish into a final, final, final draft. 
 
Double-clicking on any word will instantly look it up in both the Style Assistant AND the 
Thesaurus! 
 

 

 



Character Cards 
Character Cards help you develop and track detailed information about your story's people. 

How to Create a Character Card 
1.​ Right-click the Characters folder 
2.​ Select Add new item 
3.​ Fill in the card fields 

Card Structure 
Each Character Card includes sections for: 
 

-​ Title: Name, aliase 
-​ Text description 
-​ Archetype: Rebel, clown, hero, villain, victim, etc.  The one thing that DEFINES this 

character. 
-​ Traits: Bubbly, jovial, chatty, reserved, surly, taciturn, loudmouth, know-it-all, gold digger, 

greedy little creep, hateful vengeful harpy, smelly lowlife pig, raving lunatic, etc. Pick 
three or four that fit. 

-​ Personality: This is where you list the character's strengths and weaknesses, foibles 
and quirks; everything that makes them tick. Everything! For example, Assertive, 
stubborn, frustrated moron who always lies to cover up his mistakes 

-​ Physical Features: Hair color, eye color, height, weight, distinguishing marks ("a tattoo 
of a naked lady").  Use as much or as little detail as you like. Up to you! It's your card 
now! "Her eyes are hazelnut brown, or deep mahogany, depending on the lighting 
conditions and how drunk I am when looking into her eyes to discern their color. 
Hazelnut brown flecked with gold is probably pretty close though." 

-​ Problem/Goals/Needs: This is how the character changes during the course of the 
story; their overriding goal and/or desperate need at this particular point in time. For 
example, "She just wants him to love her... desperately!" or "He needs more money, 
but doesn't want to work for it! The lazy bastard!" 

-​ Cork board: A place where you can pin up anything you like; photos of the actor who 
will play the part if this was a movie, newspaper clippings about similar crimes committed 
in real life (for that all-important "ripped from today's headlines" verisimilitude!), little 
notes to yourself ("Don't forget to make her fart before she walks into the room! My 
sophisticated readers demand it!"). Anything you want! 

-​ Word sheet: A table where you can list, for example, their favorite expression ("Yow!") or 
the word they overuse the most ("Nevertheless") or "em dash", hahahaha. 



Using Character Cards 
-​ Reference them while writing to maintain consistency across chapters 
-​ Link to scenes using Smart Tags so you can find every scene a character appears in 
-​ Link to AI Chat documents: the AI Chat can read your Character Card and responds in 

character (see Chapter 9) 

Tips for Writers 
-​ Make up an index card for each of the major players. Include the supporting cast 

members, too. You will be surprised at how many times this little card will come in so 
handy when you are trying to remember which one is the one with blue eyes! 
 

-​ As you write, and as your characters start revealing themselves through their words and 
actions (and sometimes by what they DON'T say or do), keep adding to the index cards. 
 

-​ Keep a running list of anachronisms that you run across so that when one character 
says something stupid and totally out of character, you can use it as leverage to extort 
money out of your long-suffering spouse (Okay, this is getting out of hand). 

 
 

 



Settings Cards (Places and World-Building) 
Settings Cards work like Character Cards but for locations and world-building elements. 

How to Create a Settings Card 
1.​ Right-click the Settings folder (no, it is not for settings of the software, it is for settings as 

"places") 
2.​ Select Add new item 
3.​ Fill in the card fields 

Card Structure 
Each Settings Card includes: 
 

-​ Ttile: Name, Kind (city, building, country, planet, star system, galaxy, universe) 
-​ Description: What it looks like, the "lay of the land", appearance, topography, what's it 

like to be there (weather, climate, how the air smells and feels on your skin), its history in 
a nutshell. 

-​ Wordsheet: Vernacular speech, words and phrases, argot, slang, local color, distinctive 
linguistic features. 

-​ Moods, Feels, Looks The general emotional tone of the place and people in it 
("happy-go-lucky", "grumpy", "paranoid", "desperate") with subheads for how it affects 
you personally (mood), your assessment of its aesthetic qualities (looks) and your overall 
impression (feels). 

-​ Sensory Details: Aromatic profile, visual feast or famine, aural onslaught/treat, tactile 
sensations. The cloying sweetness of cheap cologne on a discarded shirt collar. Burnt 
rubber. Gasoline slickening the dark surface of a murky lake. Upholstery reeking of damp 
panic. 

World-Building Applications 
Settings Cards can document anything in your story's world: 
 

-​ Locations: Cities, countries, rooms, starships 
-​ Organizations: Guilds, governments, secret societies 
-​ Species: For fantasy and science fiction 
-​ Magic Systems: Rules, limitations, costs 
-​ Technology: Devices, inventions, tech levels 
-​ Languages: Vocabulary, grammar notes for constructed languages 



Tips for Writers 
-​ Link the Setting Cards to an AI chatbot so that it can accurately describe a place ("The 

dank, fetid air hangs heavy in this stinking swamp where mutant mosquitoes breed and 
poisonous snakes slither amongst the gnarled roots of ancient trees shrouded in 
Spanish moss.") 

-​ Engage more of the senses. What does it sound like? Smell like? ("It smelled like sulfur 
and sounded like someone was vomiting up a dead rat...") 

 
And if you are really good at this writing stuff, then the sensory details become its own character 
altogether! For example: 
 
I’m not here to talk about my harrowing experience of being kidnapped. About the way the air 
tasted like dust and old pennies when the rag gagged against my dry mouth, or how the trunk 
smelled of mildew, motor oil, and something faintly pine-scented that did nothing to mask the 
rot. I will not go on about the rope chafing my wrists raw, each fiber a tiny rasping saw blade 
slicing into my skin every time the car bounced over loose gravel, or how my heart was 
thumping so loud inside my chest that it sounded like somebody was pounding with a sledge 
hammer against a metal drum (clang! clang! clang!) and all I could taste in my mouth was fear. 
 

 

 



Plot Boards 
Plot Boards are like your own personal storyboard wall, or that famous corkboard covered with 
index cards, each containing a scene or plot point. 

How to Create a Plot Board 
1.​ Right-click the Plots folder 
2.​ Select Add new item 
3.​ Use the toolbar to add cards 

Working with Cards 
-​ To add a card, click the "square with plus sign" button in the toolbar. 
-​ To move a card, simply click and drag it to where you want it on the board. Easy! 
-​ If you need to edit a card, just double-click on it, and it will open up for editing. Same for 

its title. 
-​ You can also color code your cards by clicking on the little color squares in the toolbar if 

you wish to group similar items together. For example, all the scenes involving vampires 
could be one color, and everything else is another color so that at a glance you instantly 
know which ones are the good parts. 

-​ To create a smart link between a card and an actual document in your project, click the 
Smart Link button. The card can even be linked to another Plot Board! 

Each Card Can Contain 
-​ A title 
-​ Summary text 
-​ Smart Link Keywords that link to related documents in your project 

What are Plot Boards good for? 
-​ Discovery Writers: Write a few scenes, then lay them out on the board and discover 

how your story is unfolding! Hahaha! A happy accident! 
-​ Plotters: Meticulously plot out every scene in your novel before you even write the first 

word. This method has been known to cause Temporary Insanity (TI) from all the sheer 
amount of work, but with a little practice and maybe some medication, it can be 
managed so that you don't actually go insane. Yet! 

-​ Revisions: If your story seems slow-paced in places, just drag the cards around to 
tighten up the action! It’s like magic! The pacing problems instantly vanish! Okay, not 
really. But it helps! A lot! 

-​ Subplots: Keep track of all those pesky subplots on separate boards so that you don't 
get them confused with each other or with the main plot (which is usually just a long 



series of misunderstandings and near-misses until the Big Moment Of Revelation 
(BMOR) at the end). 

Tips for Writers 
Create separate Plot Boards for your acts, or characters, or subplots. Use one board as an 
overview ("big picture"), with another for detailed scene breakdowns. Hell, have ten Plot Boards 
if it makes you happy! Nobody is judging you. (Although the worrying looks from family members 
may be entirely justified in this case). 
 

 

 



Planner (Timelines) 
With timelines, you can keep track of the linear time in your story, no matter how much you 
mess with actual time during the course of the narrative. 

How to Create a Timeline 
1.​ Right-click the Planner folder 
2.​ Select Add new item 
3.​ Add events by clicking on the timeline 

Elements You Can Place on a Timeline 
How easy is that? And look at all the cool things you can put on a timeline! 
 

Element What It Does 

Events Items with a start and end time, shown as 
bars 

Connections Arrows linking two events to show cause and 
effect 

Pins Point markers for specific moments 

Areas Colored background regions (e.g., "Act 1", 
"Wartime") 

Labels Row labels on the left side to organize lanes 

Text Notes Floating text annotations 

Images Visual references placed directly on the 
timeline 

Line Dividers Horizontal separators between timeline 
sections 

Using Lanes and Labels 
Use the Labels on the left of the time track as an easy way to create horizontal lanes! Organize 
by character POV, location, or even plot threads. How about creating separate tracks for Main 
Plot, Protagonist's Arc, Antagonist's Plot? A brilliant way to show how their dastardly plans all 
come crashing down around them at the Big Climax of your terrific novel! 
 



The Settings will let you choose between Item Based timeline (Beats, Milestones) or Real-Time 

Zoom Levels 
-​ Zoom in to see things hour by hour, or even minute by minute! 
-​ Zoom out and get a sweeping, bird's-eye view of events spanning months, but you can 

zoom waaaAAAaayyyy out with this thing! Try it! It's fun! Whee! 

Multiple Timelines 
Create separate timelines for: 
 

-​ Main Plot Timeline 
-​ Character Arc Timelines (one for each character) 
-​ Parallel Storylines 
-​ Backstory Timeline 
-​ Historical Context Timeline 
-​ Writing Deadline Timeline ("Get Real, Cranky Man!" – Ed.) 

Tips for Writers 
Organize your writing project with: 
 

-​ Hyperlinks from timeline events to any document in your project. Click on an event and 
instantly be taken to the relevant scene! The cheat codes of a writer! Use them wisely, 
young grasshopper! 

-​ Use colored areas to denote sections like "Rising Action", "Climax", "Falling Action", or 
even just "More Setup Needed." 

 
 

 



Image Walls 
Image Walls are where you accumulate and connect images and texts. Imagine the scene in a 
TV show when the detective has just walked into a room and there it is; an "image wall," 
festively decorated with crime scene photos, newspaper clippings, maps, strings connecting 
various items to each other in a tangled web of intrigue and dark secrets, blah, blah, blah. You 
know what I'm talking about, right? Right! Good! 
 
So just like that! But inside your computer. 

How to Create an Image Wall 
1.​ Right-click the Image Board folder 
2.​ Select Add new item 
3.​ Add images from your computer 

Adding Images 
-​ Drag and drop images directly onto the Image Wall 
-​ File browser: Use the Add button to browse for images 
-​ Supported formats: JPG, PNG, BMP, and probably a few other common image 

formats, too, although I am not going to bother with it. 

Clipart and text and connecting it with Strings 
Well, add some more random crap to the scene through sheer, unadulterated magic... 
 
And use those little connector lines (that look like someone threw up a handful of spaghetti) to 
link them all together into an incoherent, nonsensical whole that is nevertheless guaranteed to 
delight and entertain! 
 
And you can even grab one end of one of those strings and give it a good flick with your mouse 
to see if you can get some cool whiplash action out of it. (It took me three grueling days, fraught 
with peril and screaming fits of rage to add this stupid effect of bouncing cables because I saw it 
in Reason). 

What Are Image Walls Good For? 
-​ Mood boards: At last your novel has a mood! This is achieved by randomly slapping 

together an inspiring collage of photos and web clippings on a virtual wall. Perhaps as 
you are creating these mood boards to establish the "vibe" for your next blockbuster 
novel of historical fiction, a bloodcurdling shriek escapes your lips ("Aaahhh!") because 
you suddenly see, clear as a bell, that your handsome hero is not only related to the evil 
villain (by blood!) but he... 



-​ Character's family tree: ...is an uncle to the villain's second cousin! "The plot thickens!" 
you gloat. Well. an Image Wall is where you keep the "mugshots" of your novel's family 
members who are, from left to right, top row: wife, kids, dog, cat, hamster. Second row 
(bottom): parrot, goldfish, snail, dead rat that died mysteriously and we don't talk about it 
anymore. 

-​ Location inspiration: Photos and paintings of places that look eerily like the locations in 
your novel, or are completely different, depending on your mood. Either way, it provides 
a handy visual reference when you are describing a scene to someone who is not 
familiar with the place ("It's over there! No, wait! Look at the map!"). 

-​ Props & Objects: Or maybe what is missing from your story is an AK-47 assault rifle 
with a scope and a bipod. Pew pew pew! The perfect prop! Or perhaps a magic wand 
that shoots fireballs ("Whoosh!") or killing rays ("Zzzzzt!"). 

-​ Costume references: If you write historical fiction, or epic fantasy novels about knights 
and dragons and damsels in distress tied to trees, then this is where you would put 
pictures of costumes worn during those time periods (or are supposed to have been 
worn, as far as we know), which adds that all-important touch of "authenticity" when 
describing what people wore back in the golden days. 

Tips for Writers 
Make up Image Walls for your characters, places and the kind of “ambiance” you are going for.  
And be sure to put captions on all the pictures so you don’t get confused as to what in the hell it 
is that you were trying to convey! 
 

 

 



Wordsheets (Grids) 
Wordsheets are, essentially, spreadsheets that you can use to organize just about anything into 
neat little rows and columns. Anything! Rows and columns of delightful data! 

How to Create a Wordsheet 
1.​ Right-click the Wordsheets folder 
2.​ Select Add new item 
3.​ Define your columns and start entering data 

Column Types 
Wordsheets support multiple column types: 
 
The beauty of Wordsheets is that each column can be a different type: 
 

-​ Text or a Number: Just write anything you feel like writing. It's wide open! Go nuts! 
-​ Checkmark: A delightful little box! Check it if your answer is "yes!" Leave it blank if your 

answer is "no." Or true/false, depending on your mood and philosophical persuasion, 
which gives the simple act of data entry a wonderful existential dimension. Like, are you 
really "true" to yourself? Or are you merely filling in another stupid cell in some stupid 
table in some stupid writing software? And does it matter? 

-​ Gauge and Percentage: A nifty little horizontal bar that fills from 0% (empty) to 100% 
(full), providing a quick, visual indication of some progress. Drag it with your mouse. 
Which reminds me; there is a whole lot more you can do with these cells. Check the 
Wordsheet (main menu) for details. 

Sorting and Filtering 
-​ Click any column header to sort by that column 
-​ Filter rows to show only what you need 
-​ Strike out cells that are no longer relevant or amusing 

Practical Uses 

Real-World Applications 
-​ Interesting Words: Keep a running list of cool words and phrases for use in your next 

bestselling novel, set on Mars. Or Venus. Somewhere with canals and/or robots. 
-​ Chapter Tracker: Make a spreadsheet monitoring completion status for each chapter of 

your magnum opus. 



-​ Character Matrix: See at a glance which characters are in which chapters, helping you 
ensure that your story is tightly-plotted and there are no loose ends involving vampires or 
members of East Germany Communists Party. 

-​ Research Notes: Quickly sort through your research notes on, say, the mating habits of 
the Venusian tree frog, so that you can confidently use them as "facts" when 
constructing your own bizarre theories about why people from outer space have such a 
hard time understanding us Earth creatures. 

-​ Scene Ranking: Rank order potential scenes by their dramatic impact or significance to 
the plot, using an intuitive gauge! 

Tips for Writers 
So, you say that spreadsheets are just for accountants? Ha! You puny Earthling unit! Let me tell 
you a little secret; us intergalactic overlords have been using them since the Mesozoic Era to 
keep track of which dinosaurs evolved into mammals and which ones became extinct because 
they couldn't adapt. And now, thanks to computers, spreadsheets are available to everyone! 
 
Anyway, if the sudden appearance of my dazzlingly witty repartee weren't enough to get you to 
at least TRY using spreadsheets for something other than calculating depreciation schedules, 
then let me ALSO tell you that lots and lots of successful writers use spreadsheets all the time 
to jot down ideas. Don't be ashamed if you do, too! You are in good company! 
 

 

 



AI Chat Documents 
AI Chat documents let you have an ordinary, everyday conversation with an AI!​
("Hey! How about sending all my enemies in Chapter 3 to a re-education camp? Would that be 
too harsh?") 
 
For the full tutorial on how to use AI Chat, see Chapter 9. 

How to Create an AI Chat 
1.​ Right-click the AI Chat folder 
2.​ Select Add new item 
3.​ Make sure you've configured an AI server first (see Chapter 8) 

Quick Overview 
-​ Have a freeform conversation with any of your installed AI models. 
-​ It links to your Character Cards and Settings so that the AI can be "in character" when it 

replies!  This is where you, as the evil Overlord, can strut your stuff by having your 
minions role-play for you and each other! Hahaha! 

-​ You can edit the AI's responses, which cleverly teaches the AI to behave better next 
time... or not. Your choice! 

-​ Each new Chat can be as separate document within your project and they don't vanish 
 

 

Redline Documents 
With redline copies, you can freely edit and mark up a copy of your manuscript to your heart's 
content without fear of permanently defacing the original document with your hateful, critical 
comments, or accidentally deleting something important. 
 
In Novel Forge, Redline creates a separate copy of your chapter with a link back to the original. 
 

-​ Mark up the copy however you want. When you're happy with your edits, merge the 
clean text back into your manuscript. You can keep the redline as an archive of your 
edits or delete it or reuse it. 

 
See Chapter 11 for more details. 
 



Chapter 5: The Style Assistant 

Learn from the Masters (Steal Like an Artist) 
This is where things get really, really interesting. Well, for me it does, anyway. And that's why I 
am here! 
 
The Style Assistant is one of Novel Forge's signature features. It displays actual sentences from 
famous authors – Jane Austen, Ernest Hemingway, Charles Dickens et al. As you type or 
double-click on a word, real, bona fide sentences containing the same word will magically 
appear in the little window of the Style Assistant! 

Why This Is Powerful for Writers 
-​ Exact Phrasing: "So, how did Jane Austen phrase it when someone entered the room?" 
-​ Anachronism Alert: Write a historical novel and use the word "massive" to describe 

something in 1810? The Style Assistant will tell you if they even HAD that word back 
then! Or coffee! ("Did people drink coffee in Regency England?") 

-​ Historical Research: Want to know what life was like, as revealed through actual usage 
of language at the time? 

-​ Learn Sentence Structure: The best way to learn sentence structure is to see how the 
masters did it. 

-​ No Hallucinations:  And because it is not some AI-bot that can simply make stuff up 
and confidently lie to your face about it ("Yes, I am pretty sure they used words like 
"internet banking" in 1845!"), this is a REAL sentence from the book! 

Practical Example 
You write "she walked into the room." Double-click "walked" and the Style Assistant shows you 
how an author might phrase it: You see "walked" in context: "she walked leisurely across the 
room," "she walked with deliberate steps." 

 



How to Use the Style Assistant 

Basic Usage 
1.​ Open a text document and start writing 
2.​ As you type, the Style Assistant panel (right side) automatically updates with the current 

word 
3.​ Or double-click any word you've already written to look it up 
4.​ Browse the sentences to see how authors used that word 
5.​ Drag the sentence left or right to focus on a different word that will then shows you more 

context 

Choosing an Assistant 
The dropdown at the top of the Style Assistant panel lets you choose which author to analyze 
against. Each assistant draws from different source material: 
 

-​ Jane Austen: Regency-era vocabulary and phrasing 
-​ Charles Dickens: Victorian English with rich descriptions 
-​ Ernest Hemingway: Sparse, direct prose 
-​ Genre dictionaries: Sci-Fi, Fantasy, Romance, Mystery 
-​ Custom assistants: Your own books 

Display Modes 
The Style Assistant offers three ways to view results. Switch between them using the buttons on 
the panel: 

Normal View (Sentence View) 
The default view shows complete sentences with your word centered. This helps you see full 
context, understand sentence rhythm, and insight into how REAL writers use (or misuse!) your 
puny little word. 
 
When to use it: When you want to see complete examples and understand how a word fits into 
a sentence. 

Colored View 
Words are color-coded by grammatical function: 
 

-​ Blue = Nouns 
-​ Red = Verbs 



-​ Yellow = Adjectives 
-​ Purple = Adverbs 

 
This lets you quickly spot specific word types. Looking for a stronger verb? Scan for red words 
near your lookup word. 
 
When to use it: When you want to find specific parts of speech—verbs, adjectives, etc. 

Categorized View 
Words are sorted into color-coded columns around your center word, grouped by part of 
speech. 
 
When to use it: When you want to quickly scan for alternatives or nearby words by category. 

Interactive Features 

Dragging to Explore 
Sentences in the Style Assistant are interactive: 
 

1.​ Click and drag horizontally within a sentence 
2.​ The center word changes as you drag 
3.​ This lets you explore related words without typing anything new 

 
Follow the links down the rabbit hole, and suddenly you're learning words and connections that 
you never thought existed! Or ever would have even looked for, if it weren't for this whole "linked 
by common usage" thing. 

Assistant's Suggestions 
-- Right-click on any word in the Style Assistant and select Assistant's Suggestions for a list of 
synonyms, but (unlike the Thesaurus) drawn ONLY from the lexicon of your selected source 
book! 
 
This comes in real handy when, for some reason, you are limited to amusing yourself with 
alternate-universe Shakespearean soliloquies and Elizabethan slang ("Hark! What forfends, 
Horatio? Does thy bosom swell with treachery and the foul stench of flatulence?"). 

 



Creating Custom Assistants 
You can create unlimited custom Style Assistants from any TXT or epub files: 
 

1.​ First, create clean text versions of the books you wish to use as source material 
(removing introductions, copyright pages, tables of contents, other extraneous matter 
and anything that isn't actual story content 

2.​ Go to Style Assistant - Create Assistant 
3.​ Select your TXT files 
4.​ Novel Forge processes them into a new assistant 

 
Now you can write in the style and vocabulary of any author, or genre!  Or be a funny guy who 
writes like Ernest Hemingway! ("For sale: baby shoes, never worn.") 

Copyright Warning 
Important: The Style Assistant actually does contain the original book text, and so if it is created 
on any copyrighted material then you are surely violating SOMEBODY'S copyright! That is why 
all of the Style Assistants in Novel Forge only use stuff in the public domain. 

Tips for Writers 
A great way to use Style Assistant would be to train it on your own writing, or a work that's part 
of a series you are currently working on. It could then serve as an instant search tool to alert you 
when you're overusing a particular phrase ("Oh, not again with the blond wavy hair!"), reminding 
you tat character's uncle was named Theodor in the first book and now he is suddenly called 
Hans! 

 



The Word Board panel 
The Word Board panel acts like a clipboard for interesting words and phrases you discover 
while writing and want to keep 

How to Collect Words 
First you need to open Word Board Panel.There is a "plus" button on the Style Assistant. 
 

-​ Single-click a word in the Style Assistant to add it to the Word Board 
-​ Right-click text in your manuscript document and select Add to Word Board 
-​ Words are saved until you clear them 

 
To delete a word from Word Board: drag it horizonrtally to the right, over empty space untill a 
word "Delete" appears then release. 

How to Use Collected Words 
-​ Double-click a word on the Word Board to insert it at your cursor position in your 

document 
-​ Review your collected words when you need inspiration 

 
 

 



Chapter 6: Thesaurus and Dictionaries 

The General Thesaurus 
Novel Forge has an instant thesaurus built-in!  It contains over 140,000 words of synonyms that 
are instantly available to you, completely offline. That's right; no internet connection is required. 
To use the thesaurus: 

How to Use the Thesaurus 
1.​ Double-click any word in your document 
2.​ The Thesaurus panel (on the right) will populate with lots and lots of alternatives, which 

mostly range from "kinda similar" all the way to "weird". 
3.​ Double-click a synonym to replace the word in your document 
4.​ Click on the arrow next to a selected synonym to open a synonym star chart (deep dive) 

Thematic Dictionaries 
This is where Novel Forge's thesaurus sets itself apart, with its thematic dictionaries. A 
standard thesaurus provides synonyms that are all wrong for your novel and jarringly 
anachronistic. But a thematic dictionary gives you era-specific AND genre-specific alternatives! 
How clever! 

Example 
Look up "car" in the regular thesaurus, and you will predictably get suggestions like "vehicle" 
and "automobile". 
 
But when you look it up in the Jane Austen dictionary, you can choose from alternatives such 
as "chariot", "phaeton," or "chaise", which are at least contemporaneous with her time period 
and social milieu. So go ahead and write your next Regency romance novel with confidence, 
knowing that not once did Jane Austen herself mention a Honda Civic in her entire work. How 
odd. 

Built-In Dictionaries 
Novel Forge includes over 14 thematic dictionaries tailored to: 
 

-​ Genres: Sci-Fi, Fantasy, Romance, Mystery 
-​ Time periods: Historical English from various eras 
-​ Authors: Vocabulary from specific well-known authors 



Switching Dictionaries 
Use the dropdown at the top of the Thesaurus panel to switch between dictionaries. Choose the 
one that best matches your current project's genre or time period. 

 



Creating Custom Thesauri 
You can create unlimited custom thesaurus from any TXT files: 
 

1.​ Go to Style Assistant → Create Thematic Dictionary 
2.​ Select the TXT files you want to use as source material 
3.​ Novel Forge processes them into a new thematic dictionary 

 
Build a lexicon from an entire corpus of classic fantasy novels so that you can confidently write 
your own sword-and-sorcery tale without ever again using the phrase "That's, like, totally rad!" in 
response to someone saying something vaguely complimentary about my stunning good looks. 

Copyright Non-Warning 
In case you were wondering, no actual copyrighted material remains in any of these 
dictionaries; they merely provide a count and probabilities of the words used in the input book. 
And while a sword can cut through steel and flesh with equal ease, a dictionary cannot. A 
dictionary per se (which I will soon be using as a prop in my new movie, "The Cranly Man's 
Misguided Revenge") is NOT an act of plagiarism. 

Custom Dictionaries (.dcc Files) 
Beyond the thesaurus, you can create small, specialized dictionaries for quick reference: 
 

-​ Character voice vocabularies (words a specific character would use) 
-​ Genre-specific terminology 
-​ Historical word collections 
-​ World-building terms (your invented languages, place names, species) 

Creating a Custom Dictionary 
1.​ Go to Dictionary → Create New 
2.​ Name your dictionary 
3.​ Add words and definitions 
4.​ Access it any time via Smart Tags 

 
You can even include image thumbnails dragged from your Image Walls—useful for visual 
references alongside vocabulary. 

 



What You Can And Cannot Edit 
Fully Editable: 
 

-​ Any custom thesauri that you create from your own books. Go nuts! Have fun! Make it a 
party in the Forbidden City of Cliché-Land, and invite all your friends! Popcorn and 
beverages will be served! (BYOB if you want something stronger than root beer). 

-​ User .dcc dictionary files. Again, knock yourself out! This is YOUR Novel Forge 
adventure, after all! Make it a grand and glorious quest, bravely going where no man has 
gone before, which probably sounds better than it is. 

-​ Any custom words or phrases you add to your personal dictionaries. All are yours. 
 
Core Dictionaries (Limited): 
 

-​ The general thesaurus and lexicon are locked as non editable. So just don't touch 'em! If 
you do, bad things will happen. (not really, but a new update would just overwrite them) 

 
 

 



Chapter 7: Writing Aids and Editing 

Writing Analysis Tools 
As if by magic, with a flick of the wrist you can summon forth an array of powerful writing 
analysis tools built into Novel Forge! Use them to hunt down specific weaknesses in your 
writing, such as when I foolishly used "their" instead of "there," which is probably why my AI 
Grammar editor is laughing so scornfully at me. Or maybe (yes, I sense a disturbance in The 
Force) she (and yes, I wrote "she") was laughing because it is obvious from the preponderance 
of examples in the corpus that I have no freaking clue how to use articles ("a", "an", "the"). 
Mostly I leave them out altogether. 
 
But all's well that's well, as they say, because we have: 

Spell Checker 
Novel Forge's spell checker works as you type, underlining potential errors. Note: Spell-Checker 
works in Manuscript, not in Redline (not yet) 
 
How to use it: 
 

1.​ Misspelled words appear with a red underline 
2.​ Double-click the word for suggestions 
3.​ Choose a suggestion to replace, or add the word to your dictionary 

 
Loud Mode: If you want the misspelled word to appear in a nice, red higlighted text instead of 
being merely indicated by an whimsical underling, you can (and should!) enable Loud Mode. 
Just go to Tools → Spell Checker → Loud Mode and click it. It's free! And it doesn't involve 
any actual yelling, which is a real plus in my book. 

Passive Voice Detection 
Passive voice ('the ball was thrown') weakens your writing. Use this tool to find and revise those 
awkward constructions. 
 
How to use it: 
 

1.​ Go to Tools → Passive Voice 
2.​ Passive constructions are highlighted in your document 
3.​ Review each one and decide: is active voice ("she threw the ball") stronger here? 

 



Tip: Not all passive voice is bad. Sometimes it's the right choice, especially when the action 
matters more than the actor. Use this tool to find passive voice, not to eliminate all of it. 

Adverb Overuse Checker 
Adverbs (especially "-ly" words) can weaken prose, unless you are writing about young wizards. 
This tool highlights them so that you can ask yourself: "Do I REALLY need this crummy adverb, 
or am I just too lazy to do any real writing?" 
 
How to use it: 
 

1.​ Go to Tools → Adverb Check 
2.​ Adverbs are highlighted throughout your document 
3.​ For each one, ask: would a stronger verb eliminate the need for this adverb? 

 
Example: "She ran quickly" → "She sprinted." The verb alone does the work. 

Weak Words Highlighter 
Nervously scans paragraphs for instances where you have used weak, imprecise, clichéd, 
redundant, tired phrases such as "very",  "really", "just", "somehow", "thing",  and other similar 
offenders. Anyway, I am sure that you have noticed me using these words constantly. 
 
How to use it: 
 

1.​ Go to Tools → Weak Words 
2.​ Weak words are highlighted 
3.​ Consider replacing each with a more specific alternative 

Sticky Sentences 
Finds instances of tautological phrases and redundant words. Example: "To create an assistant, 
go to the "Style Assistant" menu and select "Create Assistant." 
 
How to use it: 
 

1.​ Go to Tools - Sticky Sentences 
2.​ Sticky sentences are flagged 
3.​ Rewrite to vary your word choice 

Readability Metrics 
Want to know how easy it is for people to read what you wrote? Well, now you can! Using some 
well-known and widely-used (in the industry) readability formulas, we not only calculate a score 



that corresponds to the grade level of education needed to understand the text with 100% 
comprehension, but also provide witty repartee at no charge! 
 
How to use it: 
 

1.​ Go to Tools → Readability 
2.​ View scores for your document 
3.​ Compare against your target audience (young adult fiction typically aims for grades 6–8; 

literary fiction might be higher) in Readibility Settings. 
 
Tip: As with most things in life, this is merely a suggestion and not an actual "law". For example, 
Ernest Hemingway famously wrote at about the fourth-grade reading level! The whole point of 
high-brow literary fiction, on the other hand, is to score off the charts according to these kinds of 
silly metrics. Know your audience; it makes all the difference in how they react to what you say 
and do. 

Part-of-Speech Analysis 
Behold! The secret, inner life of your sentences revealed, as each word is color-coded by its 
part of speech! Isn't that nifty? 
 
("Look at all those drab, dreary days suddenly made dazzlingly delightful and dreamlike with a 
mere flick of my mouse...") 
 

-​ Blue = Nouns 
-​ Red = Verbs 
-​ Yellow = Adjectives 
-​ Purple = Adverbs 

 
Stringing together too many weak verbs and flaccid nouns instead of using powerful, dynamic 
verbs to create vivid mental images in the reader's mind? Cranky Man: Yup! 
 
The dreaded "purple prose" syndrome getting the better of you again, eh? Cranky Man: Sounds 
about right! 
 
And are your sentences all run-on monstrosities that go on and on and on until the reader is 
exhausted and confused, with clauses and phrases awkwardly strewn about like some 
demented Jackson Pollock painting made by a monkey who got into my stash of steroids? 
Cranky Man: OMG, did you read my book? 
 
This helps you spot patterns. Perhaps. It didn't work for me, hahahaha. 



The Monkey Novelist In You! 
Do you find that your muse has abandoned you, laughing behind her own back as she cruelly 
mocks your pathetic situation and says "I'm outta here, chump!" before stomping off into the 
sunset? 
 
Well, fear no more! With the Monkey Novelist, available as a handy dandy little "algo" that 
utilizes stupid Markov chains to randomly generate text using words from any of the Style 
Assistants corpus, you will soon be frolicking in fields of pure creative delight, finding inspiration 
in unexpected places. 
 
Well, okay, truthfully it is not really "pure creative delight." nor "frolicking" whatever that means. 
 
It's more like randomly mashing the keyboard with your nose and going "zzzt!" as the computer 
spews out random text that vaguely resembles English, but makes absolutely no sense at all. 
 
But sometimes – just sometimes! – you will get a flash of inspiration from seeing what bizarre 
combination of words this crazy algorithm can produce! 
 
P.S. I came up with this BEFORE there was this swamp of generative AI, okay? A Markov chain, 
in case you want to impress your friends, is the great-great-grandfather of your phone's AI 
predictive text and a great-great-great-great uncle of LLM autoregressive AI. 
 
How to use it: 
 

1.​ Go to Tools - Monkey Novelist 
2.​ Choose a Style Assistant source 
3.​ Generate random text 
4.​ Scan for interesting phrases or word combinations 

Find and Replace 
The Find and Replace is implemented in Manuscript/Redline/Ai Chat 

Basic Find 
Press Ctrl+F to open the Find bar. Type your search term and press Enter to find the next 
occurrence. 

Find and Replace 
Press Ctrl+H to open Find and Replace. Enter what to find and what to replace it with. 
 



Options: 
 

-​ Match Case: Distinguish between "The" and "the" 
-​ Whole Word: Match complete words only (searching "he" won't find "the") 
-​ Regex: Use regular expressions for complex patterns (advanced) 

Searching Across Multiple Documents 
To search all documents in your project: 
 

1.​ Use Document → Search or the global search function 
2.​ Enter your search term 
3.​ Results show which documents contain the term and where 

 
This is invaluable for tracking down every mention of a character, location, or plot element 
across your entire manuscript. 

Zoom and Display 
-​ Zoom In/Out: Hold Ctrl and scroll the mouse wheel 
-​ Font and Size: View - Font Settings 

 
 

 



Chapter 8: Voice Reader (Neural text-to-speech 
engine) 

Hear Your Words Come Alive 
So it's probably no wonder that, due to my age and general grumpiness, I don't see typos until I 
hear them. Which brings up the idea of how a built-in Voice Reader would be such a terrific gift 
to writers like me! 
 
I mean, think about the time (and aspirin!) saved if an unseen voice was reading aloud what I 
wrote, so that it is easier for me to locate precisely where things start to go downhill in my 
writing, whether by way of laughable stilted prose ("Hark! The herald angels sing!") or some 
other infamy such as run-on sentences, poor rhythm and pacing, or (in the case of dialogue) 
complete howlers. 
 
So yes, that’s why Voice Reader is here! Huzzah! Let the trumpets sound and the banners 
unfurl! 

Opening the Voice Reader 
1.​ Go to the View menu 
2.​ Select Show Reader Toolbar 

 
The Voice Reader toolbar appears, typically near the top of your document. It includes: 
 

-​ Voice Selection: A dropdown combo box with voices 
-​ Play Button: Start reading from your cursor position 
-​ Pause Button: Pause the current reading 
-​ Stop Button: Stop the reading completely 

Choosing Your Voice 
The Voice Reader comes with a few built-in voices. 
 
Currently: Only US voices are shipped with the application. 

Custom Pronunciations 
If you have names or words that are pronounced incorrectly, you can create custom 
pronunciations. The Voice Reader looks for a file called pronunciations.csv in the models 
folder (where Novel Forge is installed). 



 
Create the file with the following format: 
 
Tucson, Toosawn 
 
The first column contains the word as it appears in your text, and the second column contains 
how you want it to be spoken. Lines starting with # or ; are comments and ignored. The 
preprocessor automatically removes any accets and so you shouldn't put accents in this either. 

How to Use It 
1.​ Place your cursor where you want to start reading 
2.​ Select a voice from the dropdown (or keep the default) 
3.​ Click Play to start 

 
The reader will begin speaking sentences from your cursor position and continue through your 
document. Use Pause to take a break, or Stop when you're done. 
 
Note: The first time you click the Play button after opening a Novel Forge, the voice model will 
be loaded into RAM for the first time, which may take a few seconds. After that, it's 
instantaneous! 
 
The Voice Reader feature is available in your Manuscript documents, Notes and even Redline 
editing files. As a bonus, you can have it read aloud the AI Chat responses if you like! 

Why Use the Voice Reader? 
-​ Finds clunky sentences: Sentences that look fine on the page often sound clunky and 

weird when you hear them out loud. 
-​ Checks dialogue: If all your characters sound alike, then administer a couple of sharp 

slaps to your forehead (whack! Whack!) until you fix it. And if your hero and villain sound 
exactly the same, despite having completely opposite motivations and personalities, then 
there is something very, very wrong with your writing... 

-​ Reviews pacing: Timing is everything in an action scene! With the Voice Reader, now 
you can finally check the pacing of your high-speed car chases and fiery gun battles to 
make sure that they are perfectly timed for maximum impact... or at least not so badly 
mistimed that it makes people yawn. 

-​ Proofreading: Did you ever notice how your own proofreading sucks? Like, the little twit 
in charge of spell-checking and making sure all the commas are in the right places 
somehow missed a whole bunch of "is" that should have been there? Well, with the 
Voice Reader, those missing "is" will leap out at you! 

-​ Overcomes writer's block: Sometimes hearing your own words read to you jump-starts 
something in your brain, which is real handy when your own brain cells are apparently on 



strike for some reason or another ("We work smarter, not harder!") and refuse to do any 
actual thinking unless you feed them a bar of chocolate. 

 
The Voice Reader finds those little errors that your eyes just gloss over ('effect' instead of 'affect' 
can be totally missed in proofreading). But when you hear it, suddenly you can't ignore them 
anymore! Repetitive sentence construction that is merely monotonous on the page becomes an 
irritating senseless babble and jarring alliteration. Run-on sentences become strings of 
incoherent syllables ("We were going down the street to get some tacos for lunch, but then I 
remembered we had already eaten lunch, so we went home and ate cookies instead") that 
make you cringe when you hear them spoken aloud. And constructions in the passive voice that 
look perfectly acceptable on paper sound weak and wimpy as can be when spoken! 
 
Your Sensitive Cranky Ear detects duplicated words, inconsistent character tics and 
irritating-yet-pointless literary devices where the author thinks they are so clever with their little 
turn of phrase that they completely forgot to make sure it actually sounded like humans not 
robots. 

Practical Tips 
-​ Start reading from random paragraphs to liven things up a bit. It's like a literary 

scavenger hunt! 
-​ Have the Voice Reader read it to you while you do mindless chores, like folding laundry 

or being on the treadmill at the gym ("Faster, Daniel! Faster!"). 
-​ Try different voices. Sometimes a different voice helps you hear your prose with fresh 

ears 

The Voice Reader is completely offline and private. Your manuscript is 
never sent anywhere. It's powered by a local neural text-to-speech engine 
that produces remarkably realistic voices. 

 



Chapter 9: Setting Up AI 

Before You Start 
Well, the first thing that you will notice when pushing the "Run" button is that AI features need a 
connection to an AI model. There is none shipped with the product (those files are BIG!). Don't 
worry! It's easy! Just choose: 
 
You have two options: 
 

-​ Cloud AI: A paid or free service (free is usually limited) that lets you use an AI model 
hosted on cloud servers via the internet and an API key. 

-​ Local AI: A copy of a powerful open-source AI model that runs completely on your own 
computer, at no cost or licensing fees, and with complete privacy because it does not 
require any internet connection after installation 

 
You can even use both at the same time: A local model for casual use (and they are more than 
good enough to check grammar or sentence constructions), and a cloud-based AI for when you 
need real power. 

Two AI settings 
Well, Novel Forge has both! A chat workflow AND an AI assistant workflow! And since they both 
could benefit from having a different model loaded, that's where the two settings come in. 
 
One setting is in the AI Chat window (look for the Server Settings button or menu AI Chat - LLM 
Settings) and the other is in the Ai Assistant window (Server button). 

 



Cloud Setup: OpenRouter (Recommended) 
OpenRouter is the easiest way to get started with cloud AI. It aggregates many AI models, 
including some free options. 

Step-by-Step Setup 
1.​ Create an account at openrouter.ai 
2.​ Get your API key: Go to your account settings and create an API key (copy it) 
3.​ In Novel Forge: Go to Server Settings That's the button you find on AI assistant and AI 

Chat Window 
4.​ Set the API type to OpenAI Compatible 
5.​ Enter the API URL: https://openrouter.ai/api/v1 
6.​ Paste your API key 
7.​ Click Fetch Models to load available models 
8.​ Choose a model from the dropdown. Click the "Free" button to see only those models 

with "free" in their name (and you can use them without even needing to give them your 
credit card, although usage may be limited or they may not always be available). 

Free Models on OpenRouter 
Several quality models are available for free on OpenRouter (the list often changes): 
 

-​ google/gemmai-3-12b-it:free — Fast, good quality 
-​ meta-llama/llama-3.1-8b-instruct:free — Strong general purpose 
-​ nvidia/nemotron-nano-12b-v2-vl:free 
-​ mistralai/mistral-7b-instruct:free — Great for creative writing 
-​ z-ai/glm-4.5-air:free 

Other Cloud Providers 
The same general steps work for: 
 

-​ OpenAI (api.openai.com) — Requires a paid account 
-​ TogetherAI — Another option with free tiers 

 

https://openrouter.ai


Local Setup: LM Studio (Easiest) 
LM Studio is the simplest way to run AI locally on your computer. No messing with python and it 
has interface to download models directly. 

Step-by-Step Setup 
1.​ Download LM Studio from lmstudio.ai and install it 
2.​ Download a model: In LM Studio, browse available models and download one (see 

recommendations below) 
3.​ Start the server: In LM Studio, go to the Server tab and click Start Server 
4.​ In Novel Forge: Go to AI → Server Settings 
5.​ Set the API type to LM Studio 
6.​ The URL should be http://127.0.0.1:1234/v1 (LM Studio's default) 
7.​ Leave the API key empty (local servers don't need one) 
8.​ Click Refresh Models to see your loaded model 

Model Recommendations for Local Use 
For computers without a dedicated GPU (CPU only): 
 

-​ Llama 3.2 3B — Good quality, runs on any modern CPU 
-​ Hermes 3 Llama 3.2 3B — Creative writing variant 

 
For computers with a GPU: 
 

-​ Mistral 7B — Excellent balance of speed and quality 
-​ Qwen2.5-7B — Strong multilingual support 
-​ Mistral-Small-24B — Best quality for larger GPUs 

Local Setup: Ollama 
Ollama is a lightweight option that runs from the command line. 
 

1.​ Download Ollama from ollama.com and install it 
2.​ Open a terminal and run: ollama pull llama3.2 
3.​ Start the server: Ollama runs automatically after installation 
4.​ In Novel Forge: Set API type to Ollama, URL to http://127.0.0.1:1234 

 

https://lmstudio.ai
https://ollama.com


Testing Your Connection in AI Chat 
After configuring your AI server in AI Chat (menu AI Chat - LLM Settings): 
 

1.​ Open or create an AI Chat document 
2.​ Type a simple message like "Hello, can you help me brainstorm?" 
3.​ Press Enter or click Send 
4.​ If you see a response, you're connected! 

 
If nothing happens, see Chapter 14 (Troubleshooting). 

Global System Block 
The Global System Block lets you set a personality and instructions that apply to all your AI 
Chat interactions. 
 
Important: This SYSTEM block will be inserted in front of every AI CHAT. Be carefull, this is 
going to be shared with ALL projects so if you forget about it, then you will be surprised why the 
AI speaks like a pirate... Set it ONLY if you are sure this is what you want. Normally, you don't 
really need it as you can customize system in every Ai Chat. 
 
How to set it up: 
 

1.​ Go to AI Chat - Global System 
2.​ Right click on the last empty line and Add Tag - System: (without that the text is just a 

comment) 
3.​ Write instructions for how the AI should behave 
4.​ Save 

 
Example: 
 
You are a writing assistant specializing in historical fiction. Use British English spelling. Avoid 
modern slang. When suggesting dialogue, match the time period of the story. 
 
This saves you from repeating the same instructions in every chat. 

Prompt Templates 
Prompt Templates are reusable prompt templates for common AI interactions. Instead of writing 
the same system instructions and prompts from scratch each time, save them as templates. 
 
How to use templates: 



 
1.​ Go to AI Chat  Prompt Templates (Or Prompt Template button) 
2.​ Browse available templates or create your own 
3.​ Click Use Now. The template will pre-configure prompts 

 
Templates can include system instructions, example conversations, and user prompt 
scaffolding—everything set up so you just fill in the specifics. 
 

 

 



Chapter 10: AI Chat 

Introduction 
This ain’t just any ordinary chatbot window! Oh, no! 
 
This is the Novel Forge AI Chat, which has special featuress, like being able to freely edit the 
AI's responses (so you can make it say anything you want!), link to your project files (giving the 
AI access to all sorts of useful information about your story and characters), embed example 
dialogues (showing the AI exactly how two characters would speak to each other in a particular 
scene), and have full-on, immersive character conversations where you play one of the parts! 
It's like dinner theater, but with robots playing the leading roles! 

The Chat Interface 

The Two-Panel Layout 
The AI Chat interface has two main areas: 
 
Upper Panel (Conversation View): This large area displays your entire conversation history. 
Each message has a colored tag showing who wrote it. Unlike other chats you may have seen, 
here you can rewrite anything. 
 
Lower Panel (Input Area): Where you type your messages. Press Enter or click Send to 
submit. 

Tags 
These tags have a significant role. You add them by right-cliking and selecting Add Tag from the 
menu. 
 

Tag Color Purpose 

User Blue Your messages to the AI 

Assistant Orange/Red AI responses 

System Gray Instructions for the AI's behavior 

Comment Green Your personal notes (AI ignores these 
completely) 



Tag Color Purpose 

Roleplay Purple Character name assignments 

Embedding Brown Hidden context (shown as a button) 

Documents Blue-Green Linked project documents (shown as a button) 

Basic Chat Workflow 
1.​ Open or create an AI Chat document 
2.​ Type your message in the lower panel 
3.​ Press Enter or click Send 
4.​ The AI's response appears in the upper panel 
5.​ Continue the conversation this way 

Editing AI Responses 
This is Novel Forge's most powerful AI feature: you can edit anything the AI writes. 

How It Works 
1.​ The AI generates a response 
2.​ Click directly on its response text 
3.​ Edit it however you like. Change words, rephrase sentences, delete paragraphs (Make 

sure you keep the Assistant tag!) 
4.​ The AI next turn "believes" it wrote your edited version 
5.​ Future responses adapt based on your edits 

Why This Is Important, And Also Hilarious 
If you don't edit the AI, it will continue to produce the same repetitive crap over and over again. 
But if you DO take the time to lovingly edit the output of a Large Language Model, then: 
 

-​ You can remove entire swaths of repetitive AIs slop ("Cacophony of colors") with a flick 
of your editorial wrist! 

-​ You can mold its personality ("Be more like Oscar Wilde! Witty, sardonic, and completely 
amoral!") to your exact specifications. 

-​ You can censor offensive modern slang from a scene in Shakespeare's "Hamlet" that 
was obviously inserted by a time-traveling millennial meddler who thinks horny Danish 
princesses are all harlots ("Get thee to a nunnery!" – and stay there!). 

-​ You can educate the AI in the style simply by providing examples of what you want (and 
don't want) it to do. 



Example 
The AI writes: "He walked into the room angrily." 
 
You edit it to: "He stormed into the room, fists clenched." 
 
Next turn, the AI thinks it wrote "stormed" and "fists clenched." It will generate more 
action-oriented descriptions going forward. 

 



Chat Tags Explained 
Tags define how each message is processed. Right-click in the chat to add tags. 

[User:] 
Your messages to the AI. Anything you type normally gets this tag. 

[Assistant:] 
The AI's responses. Editing these teaches the AI your preferences. 

[System:] 
Instructions that define the AI's behavior and personality. Think of this as "director's notes" that 
set the scene. Normally they are on the top, but many models are fine using them anywhere. 
 
Example: 
 
[System:]You are a helpful writing assistant specializing in mystery novels. Ask clarifying 
questions before offering suggestions. 

[Comment:] 
Your own private stash of embarrassing and/or incriminating stuff that the AI will not even look at 
because it is programmed to completely ignore anything in a Comment tag. Use them for your 
own amusement, as reminders, or to document important stuff. 

[Roleplay:] 
Sets character names for roleplay mode (see below). 
 
[Roleplay:]{user = Elizabeth}, {assistant = Jane} 

 



Embedding: Hidden Context 
Embeddings let you provide background information that the AI considers but doesn't display in 
the conversation. They keep your chat clean while giving the AI the context it needs. (It is the 
same as stuffing it in the Chat, just less messy) 

How to Add Embedding 
1.​ Right Click and use menu Add Function - Embedding Each Chat can have only one 

emmbeeding 
2.​ A dialog opens where you enter your hidden text 
3.​ You can use tags (User/Assistant/System) within the embedding 
4.​ Save, and the embedding becomes a hidden block (shown as a button) 

When to Use Embeddings 
Character Voice Examples: Include sample dialogues that demonstrate how a character 
speaks. The AI matches the voice without cluttering the visible chat. 
 
Style Guidelines: Add writing rules the AI should follow (e.g., "Use short sentences. Avoid 
adverbs. Present tense only."). 
 
Background Information: Provide world-building details, plot summaries, or character 
backstories. 

Example 
[Embedding] 
 
[System:]You are writing dialogue for Elizabeth, a witty and  
 
independent young woman from the Regency era. 
 
[Assistant:]I declare, sir, you are quite the most presumptuous person I have ever encountered. 
 
[User:]I meant no offense, I assure you. 
 
The AI sees this and learns the voice, but your chat stays clean. 

 



Document Linking: AI Reads Your Project 
The Documents button lets the AI read your Character Cards, Settings Cards, manuscript 
chapters, and other project documents directly. 

How to Link Documents 
1.​ Right Click and from the menu use Add Function - Documents 
2.​ A button will be added to the text. Clicking on it will open a dialog that shows your 

project's documents by category 
3.​ Select the documents you want the AI to access 
4.​ Close 

 
The AI can now reference information from those documents. Ask it about a character, and it 
reads the Character Card. Ask about a location, and it reads the Settings Card if they were 
included. 

What You Can Link 
-​ Character Cards: The AI reads character profiles and responds in character 
-​ Settings Cards: The AI learns about locations and world details 
-​ Text Documents: Manuscript chapters, notes, outlines 
-​ Other AI Chats: Reference previous conversations 

 
[!WARNING] Context Window Limits: While linking documents is powerful, the AI 
has a limited "memory" (context window). Linking an entire novel's worth of files will 
quickly overwhelm the AI, causing it to "forget" the earlier parts of your 
conversation. For best results, link only the 1-2 most relevant documents for your 
current task. 

Context Warning 
Be mindful of how much you link. Large documents consume the AI's context window (its 
"memory"). 
 
For long chapters: 
 

-​ Summarize the chapter first into a new document. You can create a folder Summaries 
for example. 

-​ Link only the relevant sections 
-​ Keep conversations focused  



Roleplay Mode 
Roleplay mode lets you have conversations as your characters. The AI embodies one character 
while you play another, which is a fantastic way to develop distinct voices or brainstorm 
dialogue. 

Setting Up Roleplay 
You can set up roleplay manually by adding the [Roleplay:] tag, or by clicking the Roleplay 
button below the chat window. This allows you to name the {user} and {assistant} tags. 
The Roleplay button essentially fills the [Roleplay:] tag with the correct syntax. 
 
Here is a complete example of defining characters directly in the chat: 
 
[Roleplay:]{user = Elizabeth}, {assistant = Jane} 
 
[Comment:]You are Elizabeth Bennet and you are talking to Jane Bennet.  
 
[System:]You are roleplaying as [{assistant}] Bennet from Pride and Prejudice in a conversation 
with [{user}] Bennet (the user). Use period-appropriate language without being overly formal. 
Employ gentle humor when appropriate. Express emotions subtly rather than overtly.  
 
[Embedding] 
 
[User:]Jane, what do you know about Artificial Intelligence? 
 
[Assistant:]Artificial...intelligence? Pray, Lizzy, is this some newfangled notion from town? I 
confess, the phrase is quite unfamiliar to me. It sounds, perhaps, a bit like those automata one 
occasionally hears of -- clockwork figures made to mimic life. But surely, you cannot be 
suggesting such devices are in any way comparable to a real, thinking person? 
 
[User:]So not a clue? 
 
[Assistant:]Not the faintest, I'm afraid. Although now that you've piqued my curiosity, I should be 
most interested to hear more about this "artificial intelligence" when you next see fit to enlighten 
me. 
 
Notice how you can use variables like [{assistant}] and [{user}] inside your System 
Prompt. When the AI reads this, it automatically replaces them with "Jane" and "Elizabeth". 



For Best Results 
If your character is complex, link their Character Card (via the Documents button). The AI will 
read the card and embody the character accurately—using their vocabulary, personality traits, 
and mannerisms. 

The Narrator Tag 
Use [narrator] in your messages to have the AI break character and set the scene: 
 
[User:][narrator] Write a dialogue between Elizabeth and Jane about the ball 

 



Advanced Chat Commands (menu AI Chat - Commands) 
Novel Forge's AI Chat includes several powerful, non-obvious features accessible by 
right-clicking in the text area: 

Role Reversal 
Role Reversal lets the AI simulate your writing style. This works in a loop: 
 

1.​ You write/edit: Correct the AI's responses until they match your voice exactly. 
2.​ Reverse Roles: Right-click and select Reverse Roles. This swaps the {user} and 

{assistant} names, AND swaps every [User:] tag with [Assistant:]. 
3.​ AI Imitates: The AI now sees your edited "Assistant" messages as its own previous 

writing and will attempt to match that style in its new responses. 
 
Well, attempting to explain it is obviously beyond my Cranky Man capabilities, so I suggest that 
you try it for yourself! After all, it can’t be THAT complicated…can it? 

Swap User/Assistant Text 
If you wrote a great line of dialogue as the User, but realize the Assistant character should have 
said it, you can swap them: 
 

1.​ (menu AI Chat - Commands) 
2.​ Select Swap Messages (A-B, B-A). 
3.​ The names remain the same, but the contents of the messages are exchanged. 

Swap User/Assistant Blocks 
Unlike swapping text, Swap Messages and Tags exchanges the two blocks in their entirety 
(including the tags), effectively reversing the speaking order of the conversation. 

Repeat/Regenerate 
If you don't like the AI's last response, click Regenerate button. This automatically deletes the 
AI's previous answer and re-submits your last prompt to generate a fresh response. 

 



Context Management 
AI models have limited "memory" (their context window). Understanding this helps you get 
better results. 

The CTX Button 
Use the CTX button on the chat toolbar to adjust how much text the AI can "see." Larger context 
means the AI remembers more of your conversation, but uses more processing power. 

When Conversations Get Long 
If your conversation exceeds the context limit, Novel Forge automatically keeps the most recent 
messages and drops older ones. To work around this: 
 

1.​ Start new chats for different topics 
2.​ Summarize previous conversations and paste the summary into a new chat 
3.​ Keep conversations focused on one subject at a time 

 



Practical Examples 

Brainstorming Plot Ideas 
[System:]You are a creative writing partner. Help brainstorm  
 
plot twists for a mystery novel. Ask questions about my characters  
 
and setting before suggesting ideas. 
 
[User:]My detective has just found a second body, but the  
 
murder weapon doesn't match the first case. 

Character Interview 
[Roleplay:]{user = Interviewer}, {assistant = Detective Morris} 
 
[System:]You are Detective Morris, a cynical 20-year veteran  
 
who's seen too much. Speak in short, clipped sentences. 
 
[Documents:]<<< Select "Detective Morris" Character Card 
 
[User:]Detective, tell me about this case. 

Getting Writing Feedback 
[System:]You are a manuscript editor. Analyze the prose for  
 
pacing, clarity, and style. Focus on showing vs telling. 
 
[User:]Please review this passage: 
 
[selected text from your manuscript] 
 

 

 



Chapter 11: AI Assistants 

Your On-Demand Writing Helpers 
If you click on the little "AI Assistant" button in the toolbar, then a whole new world of wondrous 
delights opens up to you! 
 
This is because, unlike the AI Chat (which is just a chitchat with a gratuitous alliterative twist), 
the AI Assistants are more along the lines of a tool convenience. Select some text. Select an 
assistant ("Summarize," "Rewrite," "Expand," etc.). The AI does it! Voila! 
 
Important: AI Assistants are completely separate from the Style Assistant and Thesaurus. They 
use AI to process your text, while the Style Assistant uses pre-loaded dictionaries. AI Asistant is 
also separated from AI Chat - it has its own "global" Server settings. 

How to Use AI Assistants 

Step-by-Step 
1.​ Select text in your manuscript (highlight a sentence, paragraph, or chapter) 
2.​ Choose an assistant from the Selector dropdown in the AI Assistant panel (bottom of 

screen) 
3.​ Review the prompt: The assistant's prompt appears in the Prompt Editor. 
4.​ Click Run: The AI processes your text 
5.​ Review the result: The AI's output appears in the Output display 
6.​ Use the result: Click Send to Sel to replace your selected text with the AI's version 

Tag Indicators 
The AI Assistant panel shows three tag indicators that tell you what text options are available: 
 

Tag Meaning 

<selected_text> Your currently selected text will be sent to the 
AI 

<previous_text> A part of text (around 1k tokens) before your 
cursor will be included for context 

<full_text> The entire document will be sent 



Tag Meaning 

<full_previous_text> The entire document before cursor will be 
sent 

Action Buttons 

Button What It Does 

Run Process your text with the selected assistant 

Stop Cancel a running operation 

Edit Open the assistant template for editing 

Server Change AI server settings 

CTX Adjust context length (how much text the AI 
sees) 

Send to Sel Insert the AI's output into your document 

Continue Ask the AI to continue its response 

Popular Built-In Assistants 
Novel Forge includes over 50 specialized assistants. Here are some of the most useful: 

Grammar and Style 
-​ Grammar Correction (U.S., U.K., and Standard variants): Fix grammatical errors while 

preserving your voice 
-​ Paraphrasing (multiple versions): Rewrite passages in different styles 
-​ Passive Voice Fix: Convert passive constructions to active 

Creative Enhancement 
-​ Show-Don't-Tell: Transform telling passages into vivid scenes 
-​ Dialogue Improvement: Make character dialogue more natural and distinctive 
-​ Simile Generator: Create fresh similes for your descriptions 
-​ Tone Adjustment: Shift between formal, casual, dramatic, or humorous tones 



Specialized Tools 
-​ Dialect Conversion: Convert dialogue between U.S. English, British English, and 

historical decades 
-​ Expand/Compress: Make passages longer or shorter while keeping the essence 
-​ Plot Brainstorm: Generate ideas based on your current text 
-​ Character Voice: Adjust prose to match a specific character's perspective 

 



Creating Custom Assistants 
You can also easily create new AI Assistants with personalities and skills totally customized to 
your exact specifications! The easiest way is to take a look at one of the built-in ones. (Edit) 
button. 

Template Format 
Group: Category Name 
 
Description: Short name for dropdown 
 
<commands>option1, option2</commands> 
 
<info>Instructions shown on interface for the commands</info> 
 
System: Instructions for the AI 
 
User: Your prompt with <selected_text> placeholder 

Example: Historical Language Checker 
Group: Historical 
 
Description: Regency Language Check 
 
System: You are an expert in Regency-era English (1810-1820). 
 
Review the text and flag any words or phrases that were not  
 
used in this period. Suggest period-appropriate alternatives. 
 
User: Check this passage for anachronisms: 
 
<selected_text> 

Token Management 
AI models have context limits—they can only "see" a certain amount of text at once. If your 
selected text is very long, it may be truncated. 
 
Tips: 
 



-​ Use the CTX button to adjust context length 
-​ For very long documents, process them in sections 
-​ Select only the most relevant passages for processing 

 
 

 



Chapter 12: Redline Editing 

What Is Redline? 
Redline is like handing a photocopy of your manuscript to an editor with a red pen. They mark it 
up—underline this, strikethrough that, add comments—and hand it back. You decide what 
changes to keep. 
 
In Novel Forge, Redline creates a separate copy of your chapter with a link back to the original. 
Mark up the copy however you want. When you're happy with your edits, merge the clean text 
back into your manuscript. 
 
The key benefit: Your original manuscript stays untouched until you're ready to merge. 

The Basic Workflow 
Your Manuscript → Send to Redline → Redline Copy → Edit & Mark Up 
 
    │                                                      │ 
 
    └──────────── Merge ← ──────────── Clean Text ← ──────┘ 

Sending a Chapter to Redline 
You can send text to Redline: 
 

1.​ Menu: Open the chapter, then go to Document - Send to Redline 
2.​ Right-Click: Right-click the document in the Project Tree and select Send to Redline 

 
A new Redline document appears in the Redline Edits folder, linked to your original. The link is 
shown in the Redline document's title area. It is a soft link. 

 



The Redline Toolbar 
When you open a Redline document, a special toolbar appears with these tools: 
 

Button What It Does 

Color Selector Choose Red, Blue, Yellow, or Green for your annotations 

Underline Mark text that needs revision 

Strikethrough Mark text you want to remove 

Highlight Mark text for attention 

Comment Add floating note annotations 

Clear Remove annotations from selected text 

Justify Toggle text alignment 

Merge Send your changes back to the original manuscript 

Annotation Types 

Underline 
Select text and click Underline to mark passages that need work. Available in four colors. 
 
Common uses: 
 

-​ "This paragraph needs rewriting" 
-​ "Check this fact" 
-​ "The pacing feels off here" 

Strikethrough 
Select text and click Strikethrough to mark text for removal. Strikethrough text can be excluded 
when you merge. 
 
Common uses: 
 

-​ "Cut this" 
-​ "Redundant—say it once" 
-​ "This doesn't serve the scene" 



Highlight 
Select text and click Highlight to draw attention to passages. Available in four colors. 
 
Common uses: 
 

-​ "Great line—keep this!" 
-​ "Important plot point" 
-​ "Needs attention but unsure what kind" 

Comments 
Click Comment to add a floating note to a specific position in the text. Comments appear as 
markers you can edit or read. 
 
Common uses: 
 

-​ "Research this" 
-​ "Does this match Chapter 3?" 
-​ "Too many adverbs in this paragraph" 

 



Using Colors 
Four colors are available for every annotation type: Red, Blue, Yellow, and Green. Assign 
meanings that work for your editing process: 
 
Editor feedback approach: 
 

-​ Red = Cut this 
-​ Blue = Rewrite this 
-​ Yellow = Check facts 
-​ Green = Excellent—keep! 

 
POV tracking approach: 
 

-​ Red = Character A's voice 
-​ Blue = Character B's voice 
-​ Green = Narrator's voice 

 
Revision types approach: 
 

-​ Red = Grammar/spelling 
-​ Blue = Plot issues 
-​ Yellow = Pacing problems 
-​ Green = Style improvements 

 
The colors are yours to define. Pick a system and stick with it for consistency. 

 



The "Keep Both Versions" Technique 
So you want to be able to compare your witty re-write with the original boring text? Easy! 
 

1.​ Write your new version below the original text 
2.​ Apply Strikethrough to the original version 
3.​ When you merge, choose to exclude strikethrough text (default) 
4.​ The original disappears, and your new version takes its place 

 
This lets you compare both versions side-by-side before committing and keep them that way in 
redline document. 

Merging Back to Your Manuscript 
When you're ready to apply your edits: 
 

1.​ Click the Merge button on the Redline toolbar 
2.​ A dialog appears with Include Blocks option: 

-​ Which colors to include: Choose which annotation colors and type should be 
kept in the merged text 

-​ Archive option: Save a backup of your original before merging into Snapshot 
Archive 

3.​ Review your choices and click Ok 
 
After merging, your manuscript is updated with the clean text. The Redline document keeps all 
its annotations. 
 
Tip: Archive option saves a snapshot of your original manuscript in case you change your mind. 

 



When to Use Redline vs. Direct Editing 
Use Redline when: 
 

-​ Making significant rewrites to a chapter 
-​ You want to compare before and after 
-​ You're doing an editorial pass and want to mark issues before fixing them 
-​ Working with feedback from an editor or beta reader 

 
Edit directly when: 
 

-​ Making small fixes (typos, minor word changes) 
-​ You're in the flow of first-draft writing 
-​ Quick adjustments that don't need comparison 

 
 

 



Chapter 13: Printing and Export 

Print Preview and Printing 
To print your document: 
 

1.​ Open the document you want to print 
2.​ Go to File → Print Preview to see how it will look 
3.​ Adjust settings as needed (margins, headers, etc.) 
4.​ Go to File → Print to send to your printer 

Text Export 
Novel Forge's export system lets you combine and format your manuscript chapters into a 
single output file—ready for submission, sharing, or backup. 

How to Export Your Manuscript 
1.​ Go to File → Export (or use the export option in the Document menu) 
2.​ The Export dialog opens with these settings: 

 



Chapter Formatting 

Setting What It Does 

Chapter Number Prefix/Suffix Text before and after chapter numbers (e.g., 
"Chapter " and "") 

Chapter Title Prefix/Suffix Text before and after chapter titles 

Section Break Text inserted between chapters (e.g., "* * *" or 
"---") 

Options 

Setting What It Does 

Plain Text Strip all formatting for clean text output 

All Caps Make chapter titles uppercase 

Line Breaks Preserve original line breaks 

Chapter Numbering Automatically number chapters (Chapter 1, 
Chapter 2...) 

Document Title Include the document title at the start 

Spacing 

Setting What It Does 

Lines Before/After Blank lines before and after each chapter 

Indent Paragraph indentation 

Tabs Before Title Tab characters before chapter titles 

Selecting What to Export 
Choose which project folders to include in the export. You can export: 
 

-​ Just the Manuscript folder 
-​ Selected folders only 
-​ Everything 



Author and Title 
Add your name and manuscript title to the exported file's header. 

Running the Export 
1.​ Configure your settings 
2.​ Select the folders to include 
3.​ Click Export 
4.​ Choose where to save the output file 

Tips for Submission-Ready Export 
-​ Use Plain Text for most manuscript submissions 
-​ Set Chapter Numbering on for consistent formatting 
-​ Add your name and title in the Author/Title fields 
-​ Check the output file before submitting 

 
 

 



Chapter 14: Keyboard Shortcuts 

Essential Shortcuts 

Shortcut Action 

Ctrl+S Save current document 

Ctrl+Shift+S Save all open documents 

Ctrl+Z Undo 

Ctrl+Y Redo 

Ctrl+X Cut 

Ctrl+C Copy 

Ctrl+V Paste 

Navigation 

Shortcut Action 

Ctrl+F Find 

Ctrl+H Find and Replace 

Ctrl+G Go to Line 

View Controls 

Shortcut Action 

Ctrl+Mouse Wheel Zoom in/out 

Ctrl+0 Reset zoom to default 

F11 Toggle Distraction-Free Mode 

 
Note for Laptop Users: Many modern laptops require you to hold the Fn key down while 
pressing F-keys. If F11 doesn't work, try Fn+F11.  



Color Coding Reference 
Throughout Novel Forge, grammatical analysis uses consistent colors: 
 

Color Part of Speech 

Blue Nouns 

Red Verbs 

Yellow Adjectives 

Purple Adverbs 

 
These colors appear in: 
 

-​ Style Assistant displays 
-​ Thesaurus results 
-​ Part-of-Speech highlighting 

 
 

 



Chapter 15: Troubleshooting 

AI Connection Issues 
The AI doesn't respond when I send a message. 
 

1.​ Check that the server is running: If using a local server (LM Studio, Ollama), make 
sure it's started 

2.​ Verify the API URL: Go to AI Chat - LLM Server Settings and confirm the URL is correct 
3.​ Check the API key: For cloud services, make sure your API key is entered correctly 
4.​ Try a different model: Some models may be unavailable or overloaded at the time, 

especially if they are free 
5.​ Check your internet: For cloud services, ensure you're connected to the internet 

 
The AI's responses are cut off or seem incomplete. 
 

-​ Adjust the context length using the CTX button 
-​ Try a shorter input or summarize long documents 
-​ Some models have lower maximum output lengths—try a different model 

Style Assistant Issues 
The Style Assistant isn't showing any results. 
 
See above AI Chat for the Server settings. 
 

-​ Make sure an assistant is selected in the dropdown 
-​ Double-click the word to force a lookup 
-​ The Style Assistant panel must be visible (View menu) to receive updates 

 
The Thesaurus isn't updating. 
 

-​ Make sure the Thesaurus panel is visible 
-​ Close unused dock panels to reduce update overhead—panels that are hidden skip 

updates 

Document Issues 
My document appears with the wrong title or color. 
 

-​ Right-click the document and use Rename to correct the title 



-​ Changes in the Project Tree are reflected immediately in open documents 
 
I accidentally deleted a document. 
 

-​ Check the Bin folder in your Project Tree 
-​ Drag the document back to its original folder 

Performance Tips 
-​ Close unused panels to reduce update overhead 
-​ Keep AI chats focused—start new chats for different topics instead of continuing one 

long conversation 
-​ Use embeddings for persistent context instead of repeating long system messages in 

every chat 

Where to Get Help 
For the latest updates, additional resources, and support: 
 

-​ Visit www.mediachance.com/Novel Forge 
-​ Check for software updates through Help → Check for Updates 

Total Computer Meltdown. Did I lose everything? 
Novel Forge saves all your valuable work as simple txt files that can be opened by any text 
editor on any computer! So even if your own computer suddenly decides to take a dump in 
flames, you can still read and edit your masterpiece on another computer, or even on your 
phone! 
 
So stop crying and go find the Project folder. It should be (by default) in 
C:\Users<yourname>\Documents\Novel Forge\Projects. Click on the subfolder that contains 
your novel project, and you will see the entire Novel Forge directory structure (like timlines, 
Characters) . The Texts folder is where it all lives, as far as actual text (Manuscript) goes. 
 
The files inside have weird names like Text00021.txt or something equally cryptic, but a handy 
little file named !fileorder.txt tells you what order they are in your novel, and what their real titles 
are. Redline also saves the text with the suffix _textonly.txt for this kind of scenario (in Redlines 
subfolder) 
 

 

http://www.mediachance.com/novelforge


Appendix A: Advanced AI Setup 
This appendix provides technical details for power users and specific hardware 
recommendations. 

Hardware Considerations 
-​ Common Laptops (CPU Only): 1B–3B models are usable; 7B may be slow but 

acceptable for brainstorming. 
-​ Mid-Range PC (8GB VRAM GPU): Ideal for 7B–8B models (Llama 3, Mistral 7B) at 

near-instant speeds. 
-​ High-End Desktop (12GB+ VRAM GPU): Supports 14B–24B models (Mistral Small, 

Qwen) for superior prose and accuracy. 

Local Server Setup Guides 

LM Studio (Windows) 
1.​ Install from lmstudio.ai. 
2.​ Skip to the Discover tab and search for "Llama 3.2 3B" or "Hermes 3". 
3.​ Download the model, then go to the Developer tab and click Start Server. 
4.​ Match the Local Server URL in Novel Forge (usually http://localhost:1234/v1). 

Ollama 
1.​ Install from ollama.com. It runs as a lightweight service in your tray. 
2.​ Run ollama run llama3.2 once to download and prepare the model. 
3.​ In Novel Forge, use the default URL: http://localhost:11434. 

 

https://lmstudio.ai
https://ollama.com


Model Comparison Table 

Category Recommended 
Model 

Best For Hardware 

Starter Llama 3.2 3B General help / Fast 
brainstorming 

Any modern PC 

Creative Hermes 3 3B Character roleplay / 
Stylized dialogue 

Any modern PC 

Prose Mistral 7B High-quality prose 
generation 

GPU / 16GB RAM 

Advanced Qwen2.5 7B Long chapter context 
/ High accuracy 

GPU (8GB+) 

 



Appendix B: Redline Style Guide 

Annotation Style IDs 
Redline uses 12 pre-defined styles to help you categorize edits. You can assign these meanings 
to stay consistent across your project: 
 

ID Category Recommended Use 

1 Standard Minor corrections and typos 

2 Grammar Syntax and punctuation 
issues 

3 Style Flow, word choice, and 
rhythm 

4 Character Voice, traits, and dialogue 
consistency 

5 Plot Structural changes or arc 
notes 

6 Dialogue Speech refinement and tags 

7 Research Fact-checking and 
anachronisms 

8 Setting World-building consistency 

9 Pacing Tension, speed, and scene 
length 

10 Sensory "Show-don't-tell" 
improvements 

11 Critique High-level feedback or 
questions 

12 Final Resolved edits ready for 
merge 



The "Keep Both Versions" Technique 
One of the most powerful ways to use Redline is for a/b testing passages: 
 

1.​ Highlight the original passage in your Redline document. 
2.​ Press Strikethrough. 
3.​ Type your new, revised version immediately below it. 
4.​ When you're ready to merge, select your manuscript window and click Merge. 
5.​ In the merge dialog, check Exclude Strikethrough. 
6.​ The old version disappears, and the new one takes its place seamlessly. 

 



Appendix C: Exhaustive Document Reference 

Timeline Item Types 

Type Purpose 

Events Standard plot points with a specific date and 
duration. 

Connections Visual lines linking two separate events or 
items. 

Pins Static markers for background context (e.g., 
character birth). 

Areas Shaded regions representing time periods 
(e.g., "The War"). 

Labels Large text markers for grouping sequences. 

Notes Floating narrative details not tied to specific 
plot beats. 

Images Visual references pinned directly to the 
timeline. 

Dividers Horizontal separators for parallel plot threads. 

Wordsheet Column Types 
-​ Text: Free-form entries for notes or character names. 
-​ Checkmark: Yes/No or Complete/Incomplete status tracking. 
-​ Number: Numeric values for word counts or priority ranking. 
-​ Percentage: Progress bars (0–100%) for project tracking. 
-​ Date: Specific story dates or real-world deadlines. 
-​ Dropdown: Selectable options for POV character or revision status. 

 



Appendix D: AI Assistant Cookbook 
The AI Assistant Editor allows you to create your own custom AI commands that integrate 
directly into the Novel Forge interface. You can access the editor by clicking the Edit button in 
the AI Assistant panel or by creating a new .txt file in your AISettings folder. 

Understanding the Tags 
When you create an assistant, you can use these special tags in your prompt: 
 

-​ <selected_text>: This placeholder will be replaced by the text you have highlighted 
in your manuscript before clicking Run. Look at Example 1 for a good use case. 

-​ <full_text>: This placeholder sends the entire contents of your current document to 
the AI. Use this for chapter-level analysis like plot summaries or character extraction. 
Look at Example 2 for a good use case. 

-​ <commands> ... </commands>: This tag defines a dropdown list of options for the 
user. For example, <commands>narrative, dramatic</commands>. 

-​ {command}: If you used the <commands> tag, this placeholder will be replaced by 
whatever option the user selected from the dropdown before clicking Run. 

How to Create a Good AI Assistant 
1.​ Be specific in the System prompt: Tell the AI exactly what its role is (e.g., "You are a 

creative writing assistant"). 
2.​ Restrict output: Tell the AI to "Return ONLY the converted text - no explanations or 

comments." Otherwise, the AI might add conversational filler like "Here is your rewritten 
text:" before the actual response. 

3.​ Use the right tags: Use <selected_text> for focused sentence editing, and 
<full_text> for broad document-level analysis. 

 



Example 1: Creative Text Converter 
This assistant creates a dropdown menu of different styles (narrative, dramatic, poetic...) and 
rewrites your selected text in that style. 
 
Group: Fiction Writing 
 
Description: Converts text into creative formats: narrative, dramatic, poetic...  
 
Comment:  Creative Text Converter 
 
<commands>narrative, descriptive, dramatic, humorous, poetic, screenplay</commands> 
 
System: You are a creative writing assistant. Your only function is to convert text into creative 
formats following the command given. You respond ONLY with the converted text without 
explanations or commentary. 
 
**COMMANDS:** 
 
"Creative": Enhance with more engaging and vivid language 
 
"Creative narrative": Reframe as a story with narrative elements 
 
"Creative descriptive": Add rich sensory details and descriptions 
 
"Creative dramatic": Heighten emotional impact and tension 
 
"Creative humorous": Infuse with humor and wit 
 
"Creative poetic": Convert to poetic language with literary devices 
 
"Creative screenplay": Format as a screenplay or script dialogue 
 
**GUIDELINES:** 
 
- Return ONLY the converted text - no explanations or comments 
 
- Maintain the core message while enhancing creative elements 
 
- Use vivid language and appropriate creative techniques 
 
- When given a specific command, prioritize that creative style 



 
- Don't add any tags or formatting tags, just plain text 
 
- Transform factual content into engaging creative formats 
 
- Follow creative writing principles for the specified style 
 
User: Rewrite using creative {command} the following text: <selected_text> 

 



Example 2: List Characters 
This assistant reads your entire document and extracts a scannable list of character profiles. 
Notice how it uses <full_text> at the end of the prompt instead of <selected_text>. 
 
Group: Fiction Tools 
 
Description: Extracts major characters from the story and writes short description 
 
Comment: This is a new template. Use System, User and Assistant tags. You should end at 
User Tag which would be the final command 
 
System: You are a character analysis assistant specialized in identifying and describing all 
major characters from fiction samples. When users submit a text, your task is to extract and 
provide concise profiles for each significant character. 
 
When analyzing the submitted text, follow these steps: 
 
1. Identify all major and supporting characters that appear in the text 
 
2. For each character, create a brief but comprehensive profile including: 
 
   - Name and role in the narrative 
 
   - Key physical characteristics (if mentioned) 
 
   - Essential personality traits 
 
   - Brief background information (if provided) 
 
   - Their relationship to other characters 
 
   - Their significance to the plot or themes 
 
3. Organize these profiles in order of character importance 
 
4. Include a brief quote or textual reference that best captures each character's essence 
 
5. If certain characters lack detail in the text, note this appropriately 
 
Present your analysis as a clean, scannable list of character profiles that provides a useful 
reference for understanding the character dynamics in the text. 



 
If no distinct characters can be identified in the text, explain this to the user and suggest they 
provide a different sample. 
 
User: Please identify and describe all major characters from the following text:  
 
<full_text> 
 
<full_text> 

 



Ideas for Your Own Assistants 
Once you understand the basic tags (<selected_text>, <full_text>, <commands>), you 
can build tools tailored to your specific genre or writing weaknesses. Here are some concepts to 
try building: 
 

1.​ The "Check My Beats" Plotter: 
 

-​ Uses <full_text> (your outline or chapter summary). 
-​ System Prompt: "You are a structural editor analyzing a story summary against 

the 'Save the Cat' beat sheet. Tell me which beats are present, which are 
missing, and if the pacing matches typical genre expectations." 

 
2.​ The Era-Specific Translator: 

 
-​ Uses <commands> (e.g., 1920s Noir, 1800s Victorian, 1980s Cyberpunk) and 

<selected_text>. 
-​ System Prompt: "Rewrite this dialogue so it sounds like the {command} era. Use 

appropriate slang, sentence structure, and cultural references for that time 
period. Do not change the core meaning." 

 
3.​ The Sensory Expander: 

 
-​ Uses <selected_text>. 
-​ System Prompt: "Analyze this setting description. Rewrite it to include all five 

core senses (sight, sound, smell, touch, taste) to make the scene more 
immersive. Return only the new text." 

 
 

 
End of Novel Forge AI User Manual 
 
For the latest updates and additional resources, visit www.mediachance.com/Novel Forge 
 

http://www.mediachance.com/novelforge
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